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Version history 

Workspace Document Summary 
1.24 124.02 Updating links to point to new LSEG site. 

 124.01 The following changes were made. 
− New digital certificates 
− The DPRM connection issue, affecting Workspace 1.23 only, has been fixed. 

1.23 123.03 Added Appendix H: Unsupported packaging methods. 
 123.02 Updated Appendix J: Known issues to include DPRM connection issue. 
 123.01 The following changes were made: 

− Guide rebranded for initial LSEG Workspace pre-release. 
− Additional features added to the Configuration Manager 

1.22 122.02 The following changes were made: 
− Added Admin configuration to the Configuration override order section 
− Added the disabled contribution sources setting to the shared configuration Settings table.  

122.01 The following changes were made: 
− The Refinitiv ribbon add-ins table was updated 
− Added the Alternative streaming servers section 
− Minor changes to the shared configuration Settings table 
− Removed a no longer supported feature from the Logging section 
− Removed a fixed shared configuration file issue from the Appendix I: Known issues section 

1.21 121.05 The System Test app is now described in its own guide, which can be found here:  
− Workspace System Test Guide  

121.04 This release contains the following changes: 
− Added Configuring multiple servers section 
− Updated the Appendix J: Known issues section 

 121.03 Minor URL amendments 
 121.02 This version contains the following updates: 

− Added Uninstalling Workspace with custom paths to the Known issues section. 
 121.01 This version contains the following updates: 

− Added Logs Viewer section 
− Updated the --help commands 
− Updated the Error codes section 
− Added Mass deployment section 
− Revised the Default folder structures section 
− Some additional Workspace executable statements 
− Minor changes throughout to cover the new Workspace installer 

1.20 120.01 This version contains information about the following updates: 
− New appendix covering shared configuration file creation and settings 
− ADH documentation location added 
− Updated executable statement parameters 
− Updates to Security section, including addition of TLS subsection 
− Minor changes to the Example domain list 
− Minor update to the DPRM section 

1.19 119.02 This version contains information about the following updates: 
− Added Appendix E 
− Added VMware Horizon installation guidance 
− Other minor changes 

 119.01 This version contains information about the following updates: 
− New version of the embedded and standalone System Test application 
− Revised Workspace Help parameters 
− New Configuration Manager section and screenshot updates 
− Expanded information about the recommended LSEG Real-Time Advanced Distribution 

Server version  
− Configuration override order 
− Expanded list of Workspace executable statements 
− Added the Example domain list section 
− Screenshots depict the new Workspace UI 

1.18 118.06 Added Example domain list section to Appendix F 
 118.05 Added the Rolling back section to Appendix J: Known issues  
 118.04 Addresses a minor PDF rendering issue. 
 118.03 Minor change to the Shared configuration bug section. 
 118.02 Footnote added to Server software versions. 
 118.01 The following changes have been made to the guide: 

− Software release policy and contact details 
− System Test can now be run from Workspace 
− Post installation testing of Workspace – Excel data retrieval functions 
− Note regarding key letters - Special characters are not supported 
− Bandwidth test added to System Test 
− Updates to the Known issues section 
− Updated illustrations 

https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/W%20O%20R%20K%20S%20P%20A%20C%20E/Workspace%20IT%20Managed%20Installation%20Guide/lseg-workspace-1.24-it-managed-installation-guide%20-%20124.02%20d01.docx#_Digital_signatures
https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/W%20O%20R%20K%20S%20P%20A%20C%20E/Workspace%20IT%20Managed%20Installation%20Guide/lseg-workspace-1.24-it-managed-installation-guide%20-%20124.02%20d01.docx#_Contributions_(RtContribute)
https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/W%20O%20R%20K%20S%20P%20A%20C%20E/Workspace%20IT%20Managed%20Installation%20Guide/lseg-workspace-1.24-it-managed-installation-guide%20-%20124.01%20d01.docx#_Appendix_H:_Unsupported
https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/Workspace%20IT%20Managed%20Installation%20Guide/workspace-1.22-it-managed-installation-guide%20-%20122.02.docx#_Configuration_override_order
https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/Workspace%20IT%20Managed%20Installation%20Guide/workspace-1.22-it-managed-installation-guide%20-%20122.02.docx#_Settings
https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/Workspace%20IT%20Managed%20Installation%20Guide/workspace-1.22-it-managed-installation-guide%20-%20122.02.docx#_Refinitiv_ribbon_add-ins
https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/Workspace%20IT%20Managed%20Installation%20Guide/workspace-1.22-it-managed-installation-guide%20-%20122.02.docx#_Alternative_streaming_servers
https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/Workspace%20IT%20Managed%20Installation%20Guide/workspace-1.22-it-managed-installation-guide%20-%20122.02.docx#_Settings
https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/Workspace%20IT%20Managed%20Installation%20Guide/workspace-1.22-it-managed-installation-guide%20-%20122.02.docx#_Logging_1
https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/Workspace%20IT%20Managed%20Installation%20Guide/workspace-1.22-it-managed-installation-guide%20-%20122.02.docx#_Appendix_I:_Known
https://www.refinitiv.com/content/dam/marketing/en_us/documents/support/workspace/system-test-guide.pdf
https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/Workspace%20IT%20Managed%20Installation%20Guide/workspace-1.22-it-managed-installation-guide%20-%20122.02.docx#_Configuring_multiple_servers
https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/Workspace%20IT%20Managed%20Installation%20Guide/workspace-1.22-it-managed-installation-guide%20-%20122.02.docx#_Known_issues
https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/Workspace%20IT%20Managed%20Installation%20Guide/workspace-1.22-it-managed-installation-guide%20-%20122.02.docx#_Uninstalling_Workspace_with
https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/Workspace%20IT%20Managed%20Installation%20Guide/workspace-1.22-it-managed-installation-guide%20-%20122.02.docx#_Appendix_J:_Known
https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/Workspace%20IT%20Managed%20Installation%20Guide/workspace-1.22-it-managed-installation-guide%20-%20122.02.docx#_Using_the_Logs
https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/Workspace%20IT%20Managed%20Installation%20Guide/workspace-1.22-it-managed-installation-guide%20-%20122.02.docx#_Workspace__Help
https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/Workspace%20IT%20Managed%20Installation%20Guide/workspace-1.22-it-managed-installation-guide%20-%20122.02.docx#_Error_codes_1
https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/Workspace%20IT%20Managed%20Installation%20Guide/workspace-1.22-it-managed-installation-guide%20-%20122.02.docx#_Running_a_mass
https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/Workspace%20IT%20Managed%20Installation%20Guide/workspace-1.22-it-managed-installation-guide%20-%20122.02.docx#_Default_folder_structures
https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/Workspace%20IT%20Managed%20Installation%20Guide/workspace-1.22-it-managed-installation-guide%20-%20122.02.docx#_Workspace_executable_statements
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Workspace Document Summary 
1.17 117.06 Minor change to the Shared configuration file bug section. 

 117.05 Footnote added to Server software versions. 
 117.04 The following minor changes: 

− DPRM settings 
− Uninstallation note concerning peruser installations 
− Conflation rate footnote 

 117.03 Added sections addressing a Real-Time server disconnection issue. 
 117.02 Minor change to the known issues section regarding support for local contributions. 
 117.01 This PRE-RELEASE version contains the following changes: 

− Configuration Manager > Advanced menu field name change 
− Executable file size 
− New, additional Refinitiv digital signature (related to PCN 13469) 
− Additional detailed qualified proxy information 
− Technical Roadmap added to documents list 
− Amendment to the Known issues > Shared configuration file bug section 
− Added Installation types summary table to Installing Workspace section 

1.16 116.02 The global release version of installation guide, which contains the following minor textual 
changes: 
− System test download link provided 
− Clarification added to Workspace executable statements  
− Download path for COMODO certificate added 
− List of Excel add-ins for 1.16 added to Microsoft Office settings 
− RtContribute section added to Known issues  

 116.01 The Pre-release version of installation guide, which may be subject to change: 
− Minor textual and graphical changes throughout  
− Updated bandwidth recommendations 
− Added section on –help parameter 
− Minor updates to configuration manager section 
− Updated documentation locations 
− Updated System Test tool descriptions 
− Added JSON coding changes to troubleshooting section 
− Created Known issues appendix 

1.15 115.02 − Fixed rendering issues with the System Test screen illustration on page 6. 
 115.01 − Removed content filtering section. 

− Minor textual changes. 
− Corrected note regarding verbosity in the uninstall command lines. 
− Changes and additions to Configuration Manager section: 
− Streaming conflation field. 
− Advanced tab content. 
− Updated illustrations. 
− Added Vendor Subservice Definitions document link. 
− Added About Refinitiv Workspace dialog section. 
− Added more Operating system tools. 
− Additions to Troubleshooting: 
− Added Shared configuration bug section. 
− Added Using the Video Recorder tool section. 

1.14 114.03 − Removed content filtering section.  
− Amended note regarding --user uninstallation statement being verbose by default. 
− Updated the Troubleshooting section regarding known issues with automatically generated 

shared configuration files. 
− Corrected the introduction to the Log upload troubleshooting section. 

 114.02 − Minor correction to fix a typographic error for some references to the --sharedconfig 
parameter. 

 114.01 − Instructions for running both the standalone and embedded System Test apps 
− Shared configuration file recommendation for SSO installations 
− Instructions for running Workspace web access through Internet or private network 
− Machine installation command lines with --sharedconfig parameters 
− Expanded explanation of key letters and Office aliases 
− (Optional) Batch print service  
− Appendix B - added Export control classification, Data dictionary support, and Local mode 

support  
− New Appendix C: System Test - summarizing the tests performed by the app 
− Appendix E - amended Excel add-ins list, added Customer managed over Internet section 
− Appendix F - new Embedded Messenger section 
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About this document 

This guide describes IT-managed installations to platforms running on the following 

environments1: 

− Microsoft Windows directly 

− Citrix 2, specifically: 

− Windows application virtualization with Citrix XenApp (published app or published 

desktop) 

− Windows desktop OS virtualization with Citrix XenDesktop 

− VMware3, specifically: 

− Horizon 8 Connection Server, Agent, and Client 

− Blast display protocol 

This document details the steps and any post-installation configuration and customization 

that is required to install the application.   

Intended readership 
The LSEG Workspace Installation and Configuration Guide is intended for IT specialists that 

are responsible for the installation and maintenance of Workspace and Messenger 

standalone.  

LSEG Workspace rebranding 
This first phase of LSEG Workspace rebranding is entirely cosmetic. For changes of a 

technical nature that may impact your installation and maintenance of Workspace, you will be 

given a minimum of nine months of notice, our standard obsolescence period, through the 

PCN system. 

Software releases and end of life 
Refer to the Workspace Support Policy, which can be found in the documentation section of 

the LSEG Workspace page.  

For further information, see:  

− PCN208374 – LSEG Workspace – Rolling obsolescence policy 

− Workspace Support and Obsolescence FAQ 

 
1  Instructions for macOS installation are provided in the Workspace Basic Installation Guide. 
2  LSEG currently provides limited testing support and technical advice on Citrix Virtual Apps and Desktops 

(CVAD) solutions. However, customers deploying a CVAD solution should consider the following when 
deploying, updating, and running Workspace:  

− The impact of network latency and equipment used.  

− The potential for virtualization machines to adversely affect performance for end users.  

− Legacy products such as Eikon will not work in parallel with Workspace 
3  As summarized for Citrix, above, LSEG currently provides limited testing support for VMware and the same 

considerations should be applied when deploying. 

https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/support-policy.pdf
https://www.lseg.com/en/data-analytics/products/workspace#documentation
https://my.refinitiv.com/content/mytr/en/product-notifications/details.html?id=PCN208374
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/support-and-obsolescence-faq.pdf
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/basic-installation-guide.pdf
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Contact information 
To receive further assistance, contact Support. 

You can also provide feedback regarding this document through DocFeedback@lseg.com.   

https://my.refinitiv.com/content/mytr/en/helpandsupport.html
mailto:DocFeedback@lseg.com
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Pre-requisites 

This section summarizes the information of which you should be aware prior to commencing 

the installation of Workspace. 

In this section 
− Verifying system requirements 

− Windows-specific environments 

− Citrix-specific environments 

Verifying system requirements  
Before installing Workspace, ensure that your hardware and 

software meet the minimum requirements.  

Important: For an installation, creating a Workspace test user ID is highly recommended 
to validate the installation. For further assistance, contact your account team or Customer 
Success Manager. 

LSEG strongly recommends that 3D Graphics Processing Unit (GPU) acceleration is 
enabled. Workspace is based on Chromium, which uses the GPU for rendering 
environments. 

System and network testing  
The System Test application helps you determine whether your computer meets the 

minimum hardware, software, and connectivity requirements to run Workspace. No personal 

information is sent to LSEG during this process.  

For further information regarding the System Test applications, refer to the System Test 

Guide.  

Virtualized environments 
When designing a deployed solution, individual utilization should be considered in the 

planning. If specific information is required, it is recommended that a selection of pilot users 

is monitored so benchmark testing can be performed by the relevant vendor support team.  

Important: If you encounter an issue; LSEG requests that you confirm the issue has been 
reproduced in a non-virtualized environment. 

VDI support 
Support is included with your subscription, when Workspace is installed according to our 

system requirements on a standalone desktop PC for one user.  

Due to the inherently complex and distributed nature of these solutions, we cannot offer the 

same unconditional support as a standard desktop for the following: 

− Terminal/Citrix Server  

− VMware Server  

R E L A T E D  L I N K S  

− Download locations 

https://www.refinitiv.com/content/dam/marketing/en_us/documents/support/workspace/system-requirements.pdf
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/pre-release/system-test-guide-pr.pdf
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/pre-release/system-test-guide-pr.pdf
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− Other multi-user or virtualized environments  

Help with installing and/or operating our software in these environments is strictly limited to a 

commercially reasonable effort. While this document makes every attempt to highlight the 

issues you may encounter, we can make no guarantees regarding a successful outcome.  

If you encounter problems, we cannot investigate or escalate unless the issue is reproducible 

on a standalone desktop running Workspace, in a single instance environment. 
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Installing Workspace 

Workspace can be installed on Windows, as a User or Machine Installation, and deployed to 

CVAD.  

However, it is recognized that there is much innovation and change in our marketplace. As 

such, the content of this document is updated, as warranted by future changes in the 

marketplace, and the evolving needs of our software products. 

In this section 
− PC installation 

− Citrix installation 

− Running browser-based Workspace 

− Uninstalling Workspace 

PC installation 
This section discusses the installation of Workspace onto 

personal computers. 

Installation method summary table 

Parameter 
Location Updated 

automatically 
Windows service 

required Installation4 Launch/Update 

--user %LocalAppData%  - 

--machine-autoupdate-service %ProgramFiles% %ProgramData%   

--machine-autoupdate-no %ProgramFiles% %ProgramData% - - 

--machine-autoupdate-peruser 5 %ProgramFiles% %LocalAppData% 6 
Launch / Update 

location only 
- 

 

Workspace Help parameter options 
When installing Workspace, you can use the --help parameter to list all parameters that are 

available.  

The Command Prompt also lists all error codes that could be displayed during a Workspace 

installation. These codes are listed in the Error codes section.  

Command line statements have the following structure, where one or more <option> 

parameters are non-mandatory:  

RefinitivWorkspace-installer_x.xx.xx.exe <operation> <option>  

 
4  Default locations. These are customizable during installation. 
5  See Important note in Uninstalling Workspace. 
6  A copy of the Installation (master image) will be created for each user when they first log into the machine. If 

the version of the master image changes, the local version is refreshed when a user next logs in. 

R E L A T E D  L I N K S  

− Command line statements 
− Registry files 
− Error codes  
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All parameters are listed alphabetically in the following table: 

Parameter Purpose 

<operation>  

--machine-autoupdate-no Machine installation, with no auto-updates. 

--machine-autoupdate-peruser Machine installation, with an auto-update per user. 

--machine-autoupdate-service Machine installation, with an auto-update service. 

--uninstall Uninstall Workspace. 

--user User installation. This is the default installation option. 

<option>  

--cachepath=”<Your cache path>” Specify the cache file path. 

--client-sso=”<Your ClientSSO URL>” Allows you to set up Single Sign-On (SSO), once 
Workspace has completed installation. SSO settings are 
stored in either user-settings.json or machine-
settings.json, depending on which installation mode was 
used for Workspace. 

--forceInstall
 7

 Skips the check to ensure your system meets the pre-
requisites. 

--help Displays the list of parameters in a second command prompt 
window. 

--installpath=”<Your install path>” Specify the installation path. 

--installerlogpath=”<Your install log path>” Specify the installation log file path. 

--lang=”<lang>” Allows you to specify the installation language. Where 
<lang> is: 

en  English  

ja Japanese 

zh Chinese 

ko Korean 

--logpath=”<Your log path>” Specify the log files path. 

--messengeronly Installs Workspace Messenger only. This installation mode 
will not share the login session with Workspace. 

--sharedconfig=”<shared config file path>” Specify the path to a shared configuration file. 

--shortcut-excel=<FALSE / TRUE> Setting this parameter to false installs the product without 
the Refinitiv Workspace - Excel shortcut 

--shortcut-workspace=<FALSE / TRUE> Setting this parameter to false installs the product without 
the Refinitiv Workspace shortcut. 

--shortcuts=”<”Your shortcuts path>” Specify the location of the Refinitiv Workspace and 
Refinitiv Workspace - Excel shortcuts. Enter NONE to hide 
the shortcuts. 

--silent 
8

 No information messages are displayed during installation. 

Customizing paths 
During the installation, you have the option of determining your own path for installation files, 

logs, cache files, and shortcuts. To do this, use one of the following commands: 

Action Command 

Change install location RefinitivWorkspace-installer_x.xx.xx.exe --installpath=”<folder_path>” 

Change log location  RefinitivWorkspace-installer_x.xx.xx.exe --logpath=”<folder_path>” 

Change cache location9 RefinitivWorkspace-installer_x.xx.xx.exe --cachepath=”<folder_path>” 

Change icon shortcut 
location 

RefinitivWorkspace-installer_x.xx.xx.exe --shortcuts=”<folder_path>” 

Change installer log path RefinitivWorkspace-installer_x.xx.xx.exe --installerlogpath=”<folder_path>” 

 

 
7  Do not use this flag without a clear purpose and understanding of the impacts, as it may result in degraded 

product experience. 
8  Silent mode is enabled when installing, updating, or uninstalling Workspace, using the command line. 
9  See Cache path definition in the Known issues section. 
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You can use multiple parameters in one command line. For example:  

RefinitivWorkspace-installer_x.xx.xx.exe --installpath=”<folder path>” 
-–cachepath=”<folder_path>”  

Performing a User installation 
When you perform a user installation, files are created in the 

%LocalAppData%\Refinitiv\Refinitiv Workspace\ folder. 

To install Workspace on a user basis: 

1. Download the Workspace package.  

2. Run the .exe file or use the Workspace command lines using the command prompt app. 

In a user installation, administrator rights are not required.10 

3. Follow the on-screen instructions to install Workspace 11:  

Performing a Machine installation 12 

With the auto-update Windows service 

This is the recommended installation mode and is the 

preferred method for your organization, where: 

− Users are not allowed to run programs from areas where they have no write permissions 

on %ProgramFiles%.  

− Applications are reviewed before being approved across your organization, to ensure that 
they do not undermine application whitelisting. This is especially important for scripting 
languages, which have their own execution environment.  

For this installation, files are created in the following folder: 

Type of OS Installation Path 

Windows    Default %ProgramFiles%\Refinitiv\Refinitiv Workspace\   

 

 
10  To review help for the RefinitivWorkspace-installer_x.xx.xx.exe command, add the parameter –-help. 
11  For further details, see the Workspace Basic Installation Guide. 
12  To perform any per machine installation, you require administrator access rights. 

R E L A T E D  L I N K S  

− Installation statements 
− Shared configuration file bug 

R E L A T E D  L I N K S  

− Download locations 

https://workspace.refinitiv.com/
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/basic-installation-guide.pdf
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To install Workspace on a machine basis:  

1. Download the Workspace package 

2. Do either of the following: 

a. Run the executable, taking the Install for all 

users on this computer option 13  

− Or 

a. Open a Command Prompt window  

b. Run RefinitivWorkspace-

installer_x.xx.xx.exe --machine-

autoupdate-service --

sharedconfig="<file path>" 17 

With auto-update per user  

 This installation mode 
14 is the preferred method for your organization, where: 

− Users are not allowed to run programs from areas where they have no write permissions 

on %ProgramFiles%.  

− Applications are reviewed before being approved across your organization, to ensure that 
they do not undermine application whitelisting. This is especially important for scripting 
languages, which have their own execution environment.  

For this installation, files are created in the following folders: 

Type of OS Installation Path 

Windows    
Master image  %ProgramFiles%\Refinitiv\Refinitiv Workspace\   

Copy 15 16 %LocalAppData%\Refinitiv\Refinitiv Workspace\ 

 

Important: The master image must be updated on a regular basis – in accordance with 
the Support Policy – to avoid the situation where a new user on a machine can install a 
version of Workspace into their profile that is no longer supported.  

To install Workspace on a machine basis: 

1. Download the Workspace package 

2. Open a Command Prompt window  

3. Run RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-

peruser --sharedconfig="<file path>" 17 

Without auto-updates 

This installation mode is the preferred method for organization running hot-desking, gold 

images, non-Persistent VDIs, or Provisioning Services (PVS) with configuration to clear 

changes once user close their Windows sessions. 

 
13  For further information, see the Workspace Basic Installation Guide. 
14  See Important note in Uninstalling Workspace. 
15  Copy installation location. 
16  Once the master image has been copied to the profile of the user, the user needs to restart their machine. 
17  Defining a shared configuration file (or files, for failover purposes) is optional but strongly recommended for 

mass configuration. 

https://workspace.refinitiv.com/
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/support-policy.pdf
https://workspace.refinitiv.com/
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/basic-installation-guide.pdf
https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/Workspace%20IT%20Managed%20Installation%20Guide/lseg-workspace-1.23-it-managed-installation-guide%20-%20123.01%20-%20d02.docx#_Uninstalling_Workspace
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For this installation, files are created in the following folder: 

Type of OS Installation Path 

Windows    Default %ProgramFiles%\Refinitiv\Refinitiv Workspace\   

 

To install Workspace without auto-updates: 

4. Download the Workspace package  

5. Open a Command Prompt window 

6. Run RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-no 

--sharedconfig="<file path>" 17 

Performing an installation using your 
Single Sign On URL 

Using a shared configuration file 

Defining a shared configuration file (or files, for failover 

purposes) is optional but strongly recommended for mass 

configuration. 

Using the command line 

To install Workspace using your Single Sign On (SSO) URL, do the following: 

1. Download the Workspace package.  

2. Open a Command Prompt window. 

3. Add the appropriate parameter from the table below 18, depending on your environment: 

Environment Additional installation parameters Settings location 

User --client-sso=<client SSO URL> user-settings.json  

Machine  --client-sso=<client SSO URL> machine-settings.json 

Citrix installation 
This section addresses the currently supported scenarios for Workspace deployment to 

CVAD. However, it is also recognized that there is much innovation and change in our 

marketplace. As such, the content is updated, as warranted by future changes in the 

marketplace, and the evolving needs of our software products.  

Important! Workspace installers require administrator rights to create their own registry 
path entries. 

Installing Workspace for Citrix 
XenApp 
1. Check that no previous Eikon registry keys are set. 

 
18  This parameter should be added to the installer executable, also in combination with additional parameters. 

R E L A T E D  L I N K S  

− Customizing installation 
paths 

− Appendix D: Command line 
statements 

R E L A T E D  L I N K S  

− Installation statements 
− Configuring Single Sign On 

(SSO) for Workspace web 
access 

− Setting up config manager 
− Shared configuration file bug 

https://workspace.refinitiv.com/
https://workspace.refinitiv.com/
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2. Ensure that the following registry keys are applied, to disable Citrix API hooks for a single 

executable file: 19 

Version 
CVAD 7 

1912 LTSR 
XenApp 7.6 LTSR XenApp 7.15 LTSR 20 

Key(s) 
No 

modification 
to registry 

keys is 
required 

HKLM\SOFTWARE\Citrix\CtxHook 

HKLM\SOFTWARE\Wow6432Node\Citrix\Ct

xHook 

HKLM\SYSTEM\CurrentControlSet\servi

ces\CtxUvi 

Value name ExcludedImageNames UviProcessExcludes 

Type REG_SZ REG_SZ 

Value to add 
21 

RefinitivWorkspace.exe 22 RefinitivWorkspace.exe 
Error! Bookmark not 

defined.

 

 

3. To show the Workspace context menu when right-clicking the Windows taskbar, refer to 

the Citrix Support Knowledge Center article CTX131995, User Cannot Launch 

Application in Seamless Mode in a Provisioning Services Server when XenApp 

Optimization Best Practices are Applied. 

4. On the Citrix server, to change to installation mode, use the command line: 

Change user /install  

5. To install Workspace, use the following command line, which includes the log and cache 

paths 23, which must point to the same location from where RefinitivWorkspace.exe 

is run: 

− RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-no --

logpath=“<folder_path>” --cachepath=“<folder_path>” 

− However, it is recommended that you define a shared configuration file (or files, for 

failover purposes) using the –-sharedconfig=“<file_path>” parameter 24. This is 
optional but strongly recommended for mass configuration.  

6. Once the installation has finished, change back to execute mode, using the command 

line: 

− Change User /execute  

Publishing Workspace applications for XenApp 

To complete the installation, you must publish both Workspace and Refinitiv Workspace - 

Excel applications in Citrix XenApp. 

To do this, use your usual configuration software, whether Citrix or third party, with the 

following parameter settings:  

Product Parameter Setting 

Workspace 
Path to the executable file <installation_path>\RefinitivWorkspace.exe 

Working directory <installation_path> 

Workspace for Excel 

Path to the executable file <installation_path>\RefinitivWorkspace.exe 

Command line argument --excel 

Working directory <installation_path> 

 
19  For further information, see https:\\support.citrix.com\article\CTX107825. 
20  Reboot from the VDA required. 
21  Process names have a 14-character limit. For example, to exclude longappname.exe, you add longappname.ex. 
22  If you want to use the Session Sharing Chrome Extension, add Refinitiv-host.exe. 
23  See Cache path definition in the Known issues section. 
24  For further information, see step 3 of Setting up configuration manager. 

https://support.citrix.com/article/CTX131995
https://support.citrix.com/article/CTX131995
https://support.citrix.com/article/CTX131995
https://support.citrix.com/article/CTX107825
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Installing Workspace for Citrix 
XenDesktop 
If you use gold images, non-Persistent VDIs, or Provisioning Services (PVS) with 

configuration to clear changes after the user closes a session, you must install Workspace in 

without auto-updates mode using the following argument: 

RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-no --

sharedconfig=“<file path>”   

In most cases, the Per-Machine and Per-User installation modes of Workspace are also 

supported in Citrix XenDesktop. 

 Log and Cache paths must point to the location from where RefinitivWorkspace.exe 
is run.  

VMware installation 
This section describes the installation of products that are required for Workspace 

deployment to VMware. 

Installing Workspace for VMWare Horizon virtual app 
1. Change to installation mode: 

On the Horizon server, use the command line: 

change user /install  

2. Install Workspace: 

In a command-line interpreter, such as Command Prompt, type the following command 
line 25:  

RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-no --

logpath=”<folder_path>” --cachepath=”<folder_path>” 26 

Important! It is strongly recommended, particularly for mass configuration, that you 
define a shared configuration file (or multiple files, for failover purposes). This is done 
by using the --sharedconfig=”<file_path>” parameter.  

3. Return to execute mode: 

Once the installation has finished, change back to execute mode, using the following 
command line: 

change user /execute  

 
25  The command line is run from the folder where RefinitivWorkspace.exe file is located and contains paths to the 

required log and cache file locations. 
26  It is strongly recommended, particularly for mass configuration, that you define a shared configuration file (or 

multiple files, for failover purposes). This is done by using the --sharedconfig=”<file_path>” parameter. 

For further information about shared configuration files, see step 3 of the Setting up configuration manager and 
the Shared configuration file bug sections. 

R E L A T E D  L I N K S  

− Without auto-updates 
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Configuring virtual applications on Windows Server 

Installation is completed by publishing both Workspace and Refinitiv Workspace - Excel 

applications in the VMWare Horizon virtual app.  

To publish the applications, perform the following steps using the Horizon Console: 

1. In Horizon Console, select Inventory > Applications 

2. In the Application Pools panel, select Add > Add Manually 

3. For Workspace, in the Add Application 

Pool panel, complete the form using the 

following details:  

 

4. Click Submit 

The application appears in the Application 
Pools panel 

5. Select Add > Add Manually 

6. For Refinitiv Workspace - Excel, complete 

the form using the following details: 

 

7. Click Submit 

The application appears in the Application Pools panel 

 
27  The Display Name value is a free text field. However, the structure of the ID, Path, and Start Folder entries 

are a requirement.   

In this field… Type or select this … 

ID RefinitivWorkspace 

Display Name Refinitiv Workspace 
27

 

Path 
<install_path>Refinitiv\Refinitiv 

Workspace\RefinitivWorkspace.exe 

Start Folder 
<install_path>\Refinitiv\Refinitiv 

Workspace\ 

Entitle Users 
after Adding 
Pool 

Select this checkbox 

Multi-Session 
Mode 

Select Disabled 

In this field… Type or select this… 

ID RefinitivWorkspaceExcel 

Display Name Refinitiv Workspace - Excel 
27

 

Path <install_path>\Refinitiv\Refinitiv Workspace\RefinitivWorkspace.exe 

Start Folder <install_path>\Refinitiv\Refinitiv Workspace\ 

Parameter --excel 

Entitle Users after Adding Pool Select this checkbox 

Multi-Session Mode Select Disabled 
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8. In the Application Pools panel, click 

Entitlements 

9. In the Add Entitlements panel, click Add 

The Find User or Group panel, opposite, is 
displayed 

10. Use the fields in this panel – Domain, 

Name/User Name, and Description – 

search for existing VMware users and select 

the checkboxes next to their details 

11. Click OK 

Installing Workspace for 
VMWare Horizon virtual 
desktop 
If you use instant clone desktop pools (golden image), or automated full-clone desktop pools, 
configured to clear changes after the user closes a session, you must install Workspace 

using the no automatic update mode. To do so, use the following command line28: 

RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-no --

sharedconfig="<file_path>"  

In most cases, the Per-Machine and Per-User installation modes of Workspace are also 

supported for VMware Horizon virtual desktop. 

Running Workspace web 
access 
Workspace is also accessible through the Internet or private 

network.  

Accessing through the Internet 
To access the Workspace sign-in page:  

− Enter the following URL into your browser: 

− https:\\workspace.refinitiv.com\web  

Accessing through a private network 
To access the Workspace sign-in page:  

− Enter the following URL into your browser:  

− https:\\workspace.extranet.refinitiv.biz\web  

 
28  Although not shown in this example, as for the virtual app, the command line should include the log and cache 

paths, which must point to the same location from where RefinitivWorkspace.exe is run. 

R E L A T E D  L I N K S  

− Configuring Single Sign On 
(SSO) for browser-based 
Workspace 

https://docs.vmware.com/en/VMware-Horizon/2203/virtual-desktops/GUID-3F7F5228-26B0-47ED-B381-01B2E2C4A4B1.html
https://docs.vmware.com/en/VMware-Horizon/2203/virtual-desktops/GUID-FB9EEA35-065A-4C4E-906E-E1B9440A5AE7.html
https://workspace.refinitiv.com/web
https://workspace.extranet.refinitiv.biz/web
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Post installation testing 
Once Workspace has been installed, you can test the data retrieval functions using the 

testing tool provided in Refinitiv Workspace - Excel.  

Downloading the tool 
To download the testing tool, do the following: 

1. Run Refinitiv Workspace - Excel 

2. Under the Workspace menu:  

a. Sign in, if necessary 

b. Click Templates  

c. In Search for templates…, type test and 

press Enter 

d. In the first search result panel, Refinitiv Workspace – Microsoft Excel Functions Test, 

click the Download button  

Once downloaded, the tool template opens automatically: 

Running the tool 
After checking the Prerequisites, listed in the Instructions section, do the following: 

1. Click the Results worksheet tab 

2. Click the START THE TEST button 

The tests usually take less than a minute to run and, should an error occur, you are 
presented with diagnostic data under the relevant tab. 
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Uninstalling Workspace 

You can uninstall Workspace, by: 

− Using the installer user interface, or 

− Using a command 

Using the installer user interface 
You can uninstall Workspace using the standard add and remove functions in Windows and 

macOS 29. For example:  

1. In Windows, under Settings > Apps & features, 

select Refinitiv Workspace and click Uninstall 

2. In the confirmation prompt, click Uninstall again to 

open the installer UI, opposite  

3. Click Uninstall 

4. Once the uninstallation is complete, click Exit 

Using a command 
You can uninstall Workspace using the following 

command line: 

− RefinitivWorkspace.exe --uninstall  

Important: When the --machine-autoupdate-peruser installation method is used, 
running the uninstallation command removes the Workspace instance in the profile under 
which it is run. For instance, if the master image is removed, all clone images will remain 
installed.   

Log file location 
The uninstallation log file is stored in the %Temp%\Refinitiv Workspace Uninstall 

Logs\ folder. 

 
29  The app removal function in macOS deletes the application folder without displaying the Workspace-specific 

UI. 

R E L A T E D  L I N K S  

− Uninstallation commands 
− Launcher message 

workflows 
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Running a mass deployment 

About mass deployment 
You can deploy LSEG Workspace with your own mass deployment tool. To do so, follow the 

four stages summarized below: 

Stage 1: Prepare installation and shared configuration files 

Stage 2: Prepare the installation command line and create an install script 

Stage 3: Ensure that the installation, shared configuration, and the install script files are in a 

shared location 

Stage 4: Execute the install script or command line using your mass deployment tool 

Prepare installation and shared configuration files 
1. Download the Workspace Installer from the Workspace download page. The file has the 

following naming structure, where x.xx.xx is the version number: 

− RefinitivWorkspace-installer_x.xx.xx.exe 

2. Create a config.json file   

− For example:  

{ 

  "EIKON.CONNECTION.MODE": "private", 

  "EIKON.LOG.TRACELEVEL": "warn", 

  "REFINITIV.WORKSPACE.RUN_ABOVE_NORMAL_PRIORITY": "true", 

  "REFINITIV.WORKSPACE.TRADING.PRINTER_NAME": "Microsoft Print to PDF", 

  "EIKON.INTRANET_OVERRIDE.URL": "C:\\Workspace\\config.json", 

  "CLIENTSSO_URL.ENABLED": "true", 

  "CLIENTSSO_URL": "https:\\myapps.testsso.com", 
  "CLIENTSSO_REFINITIV_URL": "https:\\myapps.testsso.com", 
  "EIKON.STREAMING.API.LOCAL.ENABLE": "true", 

  "EIKON.STREAMING.API.LOCAL.SESSIONS": "[\"wss:\\test-ads-
sharedconfig.com:15000\WebSocket\"]", 
  "EIKON.STREAMING.API.LOCAL.DACS.USERNAME": "permit_all_exchanges", 

  "EIKON.STREAMING.API.LOCAL.DACS.POSITION": 

"%USERDETAILS.LASTNAME%_%USERDETAILS.UUID", 

  "EIKON.STREAMING.API.LOCAL.DEFAULTSOURCE": "IDN_RDF_2", 

  "EIKON.STREAMING.JETQUOTES.DESKTOP.CONFLATION.ENABLE": "true", 

  "EIKON.STREAMING.JETQUOTES.DESKTOP.CONFLATION": "3000", 

  "EIKONPROTOCOL.ISDEFAULTAPPLICATION": "true" 

} 

Prepare the installation command line and an install 
script  
For further information about installation command lines, refer to the Workspace Help 

parameter options section, under PC installation. 

For an example of an install script (install.cmd), see the Script examples section. 

 

https://www.refinitiv.com/en/products/refinitiv-workspace/download-workspace
https://myapps.testsso.com/
https://myapps.testsso.com/
wss://test-ads-sharedconfig.com:15000/WebSocket/
wss://test-ads-sharedconfig.com:15000/WebSocket/
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Ensure all necessary files are in a shared location 
The following files must be in a common location: 

− RefinitivWorkspace-installer_x.xx.xx.exe  

− config.json  

− config_fallback.json (optional) 

− install.cmd  

Execute the install script using your mass deployment 
tool 
Run the installation script using your deployment tool. 

Script examples 
This section contains examples of the following scripts for LSEG Workspace: 

− Installation 

− Update 

− Rollback 

− Uninstallation 

Install (install.cmd) script example: 

@echo off 

:------ Identify the command's parameters to install the software 

SET VERSION=1.20.38 

SET REFINITIV_WORKSPACE_INSTALLER=C:\Workspace\RefinitivWorkspace-

installer%VERSION%.exe 
SET REFINITIV_WORKSPACE_SHARED_CONFIG_FILE=C:\Workspace\config.json 

SET 

REFINITIV_WORKSPACE_SHARED_CONFIG_FALLBACK_FILE=C:\Workspace\config_fallback.

json 

SET DEPLOYMENT_MODE=--machine-autoupdate-service 

SET REFINITIV_WORKSPACE_INSTALL_PATH=C:\rw\installpath 

SET REFINITIV_WORKSPACE_LOG_PATH=C:\rw_custpath\log 

SET REFINITIV_WORKSPACE_CACHE_PATH=C:\rw_custpath\cache 

SET REFINITIV_WORKSPACE_SHORTCUTS_PATH=C:\rw_custpath\shortcuts 

:: ----- Workspace Installation ------ 

"%REFINITIV_WORKSPACE_INSTALLER%" %DEPLOYMENT_MODE% --

sharedconfig="%REFINITIV_WORKSPACE_SHARED_CONFIG_FILE%;%REFINITIV_WORKSPACE_S

HARED_CONFIG_FALLBACK_FILE%" --silent; 

:: "%REFINITIV_WORKSPACE_INSTALLER%" %DEPLOYMENT_MODE% --

sharedconfig="%REFINITIV_WORKSPACE_SHARED_CONFIG_FILE%;%REFINITIV_WORKSPACE_S

HARED_CONFIG_FALLBACK_FILE% --

installpath="%REFINITIV_WORKSPACE_INSTALL_PATH%" --

cachepath="%REFINITIV_WORKSPACE_CACHE_PATH%" --

logpath="%REFINITIV_WORKSPACE_LOG_PATH%" --

shortcuts="%REFINITIV_WORKSPACE_SHORTCUTS_PATH%" ; 
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Workspace update (update.cmd) script example: 

@echo off 

:------ Identify the command's parameters to install the software 

SET VERSION=1.21.365 

SET REFINITIV_WORKSPACE_INSTALLER=C:\Workspace\RefinitivWorkspace-

installer%VERSION%.exe 
SET DEPLOYMENT_MODE=--machine-autoupdate-service 

:: ----- Workspace Software Update ------ 

"%REFINITIV_WORKSPACE_INSTALLER%" %DEPLOYMENT_MODE% --silent; 

:: "%REFINITIV_WORKSPACE_INSTALLER%" %DEPLOYMENT_MODE% --

sharedconfig="%REFINITIV_WORKSPACE_SHARED_CONFIG_FILE%;%REFINITIV_WORKSPACE_SH

ARED_CONFIG_FALLBACK_FILE% --installpath="%REFINITIV_WORKSPACE_INSTALL_PATH%" 

--cachepath="%REFINITIV_WORKSPACE_CACHE_PATH%" --

logpath="%REFINITIV_WORKSPACE_LOG_PATH%" --

shortcuts="%REFINITIV_WORKSPACE_SHORTCUTS_PATH%" ; 

 

Rollback (rollback.cmd) script example: 

@echo off 

:------ Identify the command's parameters to rollback the software 

SET REFINITIV_WORKSPACE_INSTALL_PATH=C:\Program Files\Refinitiv\Refinitiv 

Workspace 

:: ----- Workspace Uninstallation ------ 

"%REFINITIV_WORKSPACE_INSTALL_PATH%\RefinitivWorkspace.exe" –rollback --

silent; 

 

Uninstallation (uninstall.cmd) script example: 

@echo off 

:------ Identify the command's parameters to uninstall the software 

SET REFINITIV_WORKSPACE_INSTALL_PATH=C:\Program Files\Refinitiv\Refinitiv 

Workspace 

:: ----- Workspace Uninstallation ------ 

"%REFINITIV_WORKSPACE_INSTALL_PATH%\RefinitivWorkspace.exe" –uninstall --

silent; 
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Configuring Workspace 

You can configure Workspace using the Configuration 

Manager, which is accessed by 

running the Workspace executable 

with the --config-manager 

parameter in a Command Prompt 

window or by selecting the Help > 

Configuration Manager option in 

Workspace.  

In this section 
− Setting up config manager 

− Creating a new config file 
manually 

− Configuring Single Sign On 
(SSO) for browser-based 
Workspace 

Configuration 
Manager command lines 
The command line you use depends on the installation type: 

− For User installations, use the command:  

“<InstallDir>\Refinitiv\Refinitiv Workspace\RefinitivWorkspace.exe”  

--config-manager  

− For Machine installations, use the command: 

“<InstallDir>\Refinitiv\Refinitiv Workspace\RefinitivWorkspace.exe”  

--config-manager --machine  

Setting up configuration 
manager 
In the Configuration Manager, choose your settings for the 

following panels: 

1. In the Network panel, set the connection type in your 

environment to either Internet (the default value) or private network. 

2. In the Client SSO panel, if you have SAML 2.0 set up, enter the URL in the Client 

Single Sign On (SSO) field.  

3. In the Shared Configuration panel, select whether you are using a shared configuration, 

which overrides other settings.  

R E L A T E D  L I N K S  

− Shared configuration 
installation statements 

− Server software versions 
− Logs 
− Converting and modifying an 

Eikon configuration file 

R E L A T E D  L I N K S  

− Configuration Manager 
parameters 

− Customer managed over 
Internet 
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Important! Defining a shared configuration file (or files, for failover purposes) is optional 
but strongly recommended for mass configuration, as it allows you to define configuration 
parameters for all users from a single location. 

Workspace uses different settings.json files 
30 based on the type of installation: 

− For User installations, the file stores user-specific settings that are controlled by the 

user and can be found in the following location: 

%AppData%\Refinitiv\Refinitiv Workspace\Config\user-settings.json  

− For Machine or Hot-Desking installations, the file stores machine-specific settings that 

are controlled by elevated computer administrator rights and can be found in the 

following location: 

%ProgramData%\Refinitiv\Refinitiv Workspace\Config\machine-

settings.json 

You can specify one or, for failover purposes, more configuration files that can be used 
across multiple desktops by putting these files on a shared drive or Web server (formerly 
Configuration Proxy concept).  

To do this:  

a. Click Export and navigate to the configuration file, <override_settings>.json, 

from the Configuration Manager. 

b. Place this file on a shared drive or a Web server. 

c. Enter the URL or UNC path of the file into the installation command line, or add this 

path into the Configuration Manager directly. For example: 

\\myserver\config\refinitiv\override-settings.json 

4. In the Streaming panel, you can choose streaming sources and whether to activate 

streaming conflation.  

The Streaming Conflation 
rate 

31 is used for desktop 
performance management by 
reducing CPU usage in 
downloading streaming data. 
In effect, it reduces data 
refresh rate from the default 
to every 1.5, 3, or 6 seconds.  

5. Also, in the Streaming panel, 

choose your Streaming Data 

Retrieval source. Data can 

be streamed from either a 

Refinitiv Data Platform or by defining one or more local LSEG Real-Time Advanced 

Distribution Servers (formerly ADS).  

 
30  A shared <override_settings>.json configuration file takes priority over local user-settings.json or machine-

settings.json configuration files. When using the –-sharedconfig parameter, Workspace reads the 
configuration from the specified location every time it is launched. 

For further information, see Shared configuration file bug section. 
31  Currently, this capability is for Workspace desktop access only and will not affect the conflation settings of the 

Workspace add-in running under Microsoft Office.  

On Workspace desktop, the highest generally supported conflation rate is 300ms. However, certain 
exceptions, such as news and chart apps, can run at higher update rates. 

file://///myserver/config/refinitiv/override-settings.json
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In Configuration Manager 
32, you can configure the WebSocket 

33 protocol to connect to 
the Workspace platform for streaming services:  

− WebSocket Secure (wss:\\) for encrypted connections, and 

− WebSocket (ws:\\) for unencrypted connections 

Additional customer-managed sites use this connectivity to create a connection to the 
local LSEG Real-Time Advanced Distribution Server.  

Some proxy servers may not support (or have disabled support for) the WebSocket 
protocol, which may cause Workspace streaming-related features not to work. 

You must do the following:  

a. For Internet, allow WebSocket connectivity to the following URLs: 

*.refinitiv.com  

*.refinitiv.net  

b. For Delivery Direct, allow WebSocket connectivity to the following URLs: 

*.refinitiv.biz  

*.refinitiv.net  

6. In the Streaming > Servers 

panel, enter the LSEG Real-

Time Advanced Distribution 

Server IP address and 

hostname, together with the 

port 34. The default LSEG 

Real-Time Distribution System 

(formerly TREP) port for 

WebSocket is 15000.  

Click + to add multiple servers, 
which are called in turn if 
connection to the Primary 
server fails. 

7. In the Streaming > Feeds panel, configure feeds provided by local LSEG Real-Time 

Advanced Distribution Server. 

In supported Workspace versions, key letters 
35 can be used as single-character shortcuts 

to additional feed sources. For example, LSEG Real-Time Advanced Transformation 
Server (formerly ATS) is key letter A.  

For Office aliases 
36, there is a limit of 32 characters.  

8. In the Streaming > DACS panel, enter the LSEG Real-Time Data Access Control 

System username and position.  

 

 

 
32  Other protocols can be configured in your shared configuration file. For more information, see the Alternative 

streaming servers section. 
33  The WebSocket(ws) protocol provides full-duplex communication channels over a single TCP connection.  For 

further information, see RFC 6455: The WebSocket Protocol (rfc-editor.org). 
34  Only one server or DNS can be entered for each line. 
35  Workspace supports only standard ASCII (Latin) alphabetic characters. That is, the values A-to-Z or a-to-z. 
36  A subset of ASCII printable characters is supported. That is, the values a-to-z, A-to-Z, and 0-to-9. Special 

characters (#, $, &, and so on) are not supported. 

https://www.rfc-editor.org/rfc/rfc6455.html
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9. In the Printers panel, select the 

default printer or output mechanism 

that is to be used to print trading 

tickets silently. That is, without the 

need to select the printer each 

time.  

 

 

 

 

 

10. In the Other panel, you can choose 

whether Workspace is to run at 

above normal priority 
37 by selecting 

the Run At the highest Available 

Process Priority Level checkbox. 
38  

You can also select whether links 
from LSEG apps open in 
Workspace or Eikon. 

39  

Finally, the Select trading keypad 
mode applies your chosen keypad 
lighting scheme to the trading 
keypad. 

 

 

 

 

11. In the Logs panel, you can modify 

the default path for log files, 

changing from the folder path 

chosen during installation.  

You can choose the depth of 
logging required.  

You can also activate the web 
logger to troubleshoot networking 
issues. 
 

 

 
37  Currently, this capability is for Workspace running on Windows only and will not affect the process priority of 

Workspace on macOS or the add-in running under Microsoft Office. 
38 This can also be achieved by using the command line parameter --run-above-normal-priority. For more 

information, see Workspace executable statements. 
39 You are unable to switch between Eikon 4.0 and Workspace where there was a Citrix installation of 

Workspace. In Citrix we do not support multiple applications to be installed concurrently (Jira ref: EFO-9593). 

https://jira.refinitiv.com/browse/EFO-9593
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12. In the Cache panel, you can define 

a new folder location for cache 

files, changing from the folder path 

chosen during installation.  

You can also choose to clear all 
cache folders or only those folders 
of Electron or your Workspace 
apps. 
 
 
 
 

13. Finally, in the Tools panel, use the 

Eikon 4 configuration converter tool 

to convert an existing Eikon 

configuration file to Workspace-

compatible .json format. 

For further information, see the 
section below. 

Converting and modifying an Eikon 
configuration file 
For test purposes, in the Tools panel of the Configuration Manager, you can use the Eikon 4 

configuration converter to convert an existing OverrideConfiguration.xml file to .json 

format. 

To convert and modify an existing file: 

1. Click Eikon 4 Configuration Converter. 

2. Select your saved .xml file. For example:  

\\myserver\config\refinitiv\OverrideConfiguration.xml 

3. Click Open.  

The file is converted, and the converted configuration file is then displayed. 

4. Click OK.  

5. [Optional] Change your Network and SSO configuration.  

6. Check that the Streaming settings are correct and make any necessary changes. 

7. Click Export to create a new file with a .json extension. 

Warning: The converted .json file still contains legacy configuration settings from Eikon, 
which could potentially raise issues. 

Creating a new configuration file manually 
To create a clean Workspace configuration file: 

1. Delete your currently loaded configuration file. 
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2. Copy specific parameters from the Eikon Configuration Manager to the Workspace 

Configuration Manager.  

Parameters in the Eikon Configuration Manager largely share the same names as their 

counterparts in Workspace. However, the following table lists the exceptions (parameter 

name and location): 

Eikon Workspace 

Distributors 

Configuration: Customer Managed (Local 
Configuration Files) > Real-Time tab > ADS 

Connection – RSSL protocol 

Hostname or IP 

Streaming > Servers 

User Name 

Configuration: Customer Managed (Local 
Configuration Files) > Permissions tab > DACS 

Identification 

Username 

Streaming > DACS 

 

For more complex environments and further support, contact Workspace technical support, 

who can assist in converting the content of the OverrideConfiguration.xml and 

RFA.RFA-configuration-files. 

Configuring Single Sign On (SSO) for 
Workspace web access 
Required configuration for when LSEG is the Service Provider (SP): 

− Embed the Workspace Web access URL within the Identity Provider (IDP) initiated login 
URL. This redirects to Workspace after a successful login.  

For example: 

https:\\id-abc.com\abc-

sso\eikonweb?RelayState=https:\\workspace.refinitiv.com\web  

The appropriate attribute name must be used, as indicated by the IDP software, for 

example, RelayState or TargetResource. 

 

mailto:customersupport@refinitiv.com
https://id-abc.com/abc-sso/eikonweb?RelayState=https://workspace.refinitiv.com/web
https://id-abc.com/abc-sso/eikonweb?RelayState=https://workspace.refinitiv.com/web
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Appendix A: Folders and files 

In this section 
− Packages 

− Server software versions 

− Executable files 

− Digital signatures 

− Registry files 

− Configuration files 

− Shortcuts 

− Folder structures 

− Proxies 

Packages  
This document can be used by IT to create an installation package and provide 

documentation for future updates to the application. 

Download locations  
You can download the latest version of the installation file, RefinitivWorkspace-

installer_x.xx.xx.exe, from the locations listed in the table below.  

Location Link 

Internet https:\\workspace.refinitiv.com 

Private network https:\\workspace.extranet.refinitiv.biz 

 

Executable file sizes 
The installer executable size is operating system dependent: 

Operating System Size (Megabits) 

Microsoft Windows ~100 

Apple macOS ~200 

 

Server software  
Important: DACS Permission Synchronization for Workspace is recommended – rather 
than the Deployed Permissions Reconciliation Manager (DPRM) service - to prevent 
misconfiguration or permission issues between the Refinitiv Data Platform and local LSEG 
Real-Time Distribution System (formerly TREP). 

While we recommend DACS, for information regarding the configuration of the DPRM 
service, refer to Appendix F: Settings. 

https://workspace.refinitiv.com/
https://workspace.extranet.refinitiv.biz/
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Versions 
The following table lists the LSEG Real-Time Distribution System (formerly TREP) server 

software version requirements: 

Server software Version 

LSEG Real-Time Advanced Distribution Server (formerly ADS) 3.440 or higher 

LSEG Real-Time Data Access Control System 7.241 or higher 

Creating an internal connection 
To create a connection to the LSEG Real-Time Distribution System, you must download the 

Data Dictionary from a LSEG Real-Time Connector (RTC) or LSEG Real-Time Advanced 

Distribution Server (formerly ADS).   

However, to do so, you must do either of the following: 

− Set *maxOutputBuffers in the LSEG Real-Time Distribution System to 5000, or 

− Use the following multi-part dictionary setting 
42 to enable the download to be performed: 

*<XYZ>*enableMultipartDictionary : True 

Configuring multiple servers 
Up to eight additional LSEG Real-Time Advanced Distribution Servers can be added to a 

custom43 configuration. This is done by using the Streaming > Servers panel of the 

Configuration Manager or by using the following statement: 

EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.<n>  

Where <n> is a number between 1 and 8. 

For example: 

/*  

Each server can have more than one URL, where each subsequent URL acts as a 

failover for the specific server 

*/ 

// Main server 

// 

"EIKON.STREAMING.API.LOCAL.SESSIONS": 

"[\"ws://ads01:15000/WebSocket\",\"ws://ads02:15000/WebSocket\",\"ws://ads02:15

001/WebSocket\"]", 

// 

// Additional server 

// 

"EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.1": 

"[\"ws://example01:15000/WebSocket\",\"ws://example02:15000/WebSocket\",\"ws://

example03:15001/WebSocket\"]" 

Important: Additional servers work only if the main server connects successfully. 

 
40  Issues in the L1 and L2 releases of LSEG Real-Time Advanced Distribution Server version 3.5.2 prevent 

Workspace from functioning and cannot be used. However, these issues were subsequently addressed in the 
L3 release. As such, to run the Contribution function, installing version 3.5.2 L3 (or higher) is required. For 
further information, see the LSEG Real-Time Advanced Distribution Server version issues section. 

41 The specified version requirement is for DACS Permission Synchronization only. 
42  No change to the maxOutputBuffers parameter is required. 
43  Additional servers can only be configured in user-settings, machine-settings, or shared configuration files. 

Configuration Manager support will be made available in a future version. 
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Executable files 
The core installation of Workspace has the following executables:  

Process Name Service 

RefinitivWorkspace.exe LSEG Workspace (the main Workspace process) 

Refinitiv-host.exe Session Sharing Chrome Extension 

RWupdaterService.exe Software update installation service 

Refinitiv.Workspace.BatchService.UserInteraction.exe (Optional) Batch print service 
44 

Setup.exe Called by the main processes to perform various 
sub-processes 

 

Workspace uses .zip for updates. This may change in future releases, when smaller (delta) 

installation packages are introduced. 

Digital signatures 
The executable (.exe) and dynamic link library (.dll) files are digitally signed. 

From Workspace version 1.24, these files will be signed using new digital certificates. This 

code signing certificate retains the same Issuer value but has different Subject and 

Thumbprint values. The new certificates do not impact builds of Workspace released prior 

to version 1.24.  

For further information, refer to PCN208112 - LSEG Workspace 1.24 - New digital certificate. 

Digital certificates for Workspace 1.24 or higher 

LSEG signature 

Publisher London Stock Exchange Group PLC 

Subject C=GB/S=London, City of/O=London Stock Exchange Group plc/CN=London Stock 
Exchange Group plc 

Issuer C=GB/O=Sectigo Limited/CN=Sectigo Public Code Signing CA R36 

Thumbprint 5E56E4978E9D9F19C1298C55E1E6373DFAF44A6F 

Expiration Friday, April 24, 2026, 11:59:59 PM 

macOS signature 

Publisher REFINITIV US LLC 

Subject C=US/O=REFINITIV US LLC/OU=YHNVBQZ486/CN=Developer ID Application: 
Refinitiv US LLC (YHNVBQZ486)/UID=YHNVBQZ486 

Issuer C=US/O=Apple Inc./OU= Apple Certification Authority/CN=Developer ID 
Certification Authority 

Thumbprint 148A8BC109B61AB34D6688249545B40983E3DD44 

Expiration Friday, September 8, 2028, 03:17:30 GMT 

Digital certificates for Workspace 1.23 or earlier 

All Desktop and native apps files stamped with the previous or expired certificates are not 

affected by this change and will remain validly signed without any time limit. 

 
44 The Batch Print service is an optional download, used to print or save documents from the search results grid.  

The service can be downloaded using the following URL: 
https:\\cdn.refinitiv.com\public\packages\batchsaveinstall\RefinitivWorkspaceBatchService.msi  

https://my.refinitiv.com/content/mytr/en/product-notifications/details.html?id=PCN208112
https://cdn.refinitiv.com/public/packages/batchsaveinstall/RefinitivWorkspaceBatchService.msi
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Refinitiv signatures 

Publisher REFINITIV US LLC 

Subject C=US/PostalCode=10036/S=New York/L=New York/STREET=3 Times 
Square/O=REFINITIV US LLC/CN=REFINITIV US LLC 

Issuer C=GB/S=Greater Manchester/L=Salford/O=Sectigo Limited/CN=Sectigo RSA 
Code Signing CA 

 

Publisher45 REFINITIV US LLC 

Subject C=US/S=New York/O=REFINITIV US LLC/CN=REFINITIV US LLC 

Issuer C=GB/O=Sectigo Limited/CN=Sectigo Public Code Signing CA R36 

Thumbprint faeb75e9e11605257a0c9b32c8c1f4aa61245276 

Expiration Friday, November 24, 2023, 11:59:59 PM 

Microsoft signature 

Publisher Microsoft Corporation 

Subject C=US/S=Washington/L=Redmond/O=Microsoft Corporation/CN=Microsoft 
Corporation 

Issuer C=US/S=Washington/L=Redmond/O=Microsoft Corporation/CN=Microsoft Code 
Signing PCA 2010 

macOS signature 

Publisher REFINITIV US LLC 

Subject C=US/O=REFINITIV US LLC/OU=YHNVBQZ486/CN=Developer ID Application: 
Refinitiv US LLC (YHNVBQZ486)/UID=YHNVBQZ486 

Issuer C=US/O=Apple Inc./OU= Apple Certification Authority/CN=Developer ID 
Certification Authority 

Thumbprint B69FD35BFD9D7FFE877DCF570A4EFC7D4E8ADCFA 

Expiration Wednesday, October 16, 2024, 14:47:34 GMT 

Registry files 
Installation mode Description Registry key User 

User  The registry is deployed only once, at 
installation time 

HKCU46  Current user 

Machine with an auto-
update per user  

The registry is deployed multiple times, 
as it depends on Active Setup 

HKCU, HKLM  Every user (Separate 
user profile) 

Machine with auto-update  
service or no auto-updates 

The registry is deployed only once, at 
installation time. 

HKLM47 Every user 

 

Configuration file settings  
The following settings are customizable in your .json configuration file. 

Setting Customization 

EIKON.STREAMING.API.LOCAL.ALLOWHOSTEDFALLBACK Defining this setting as false, indicates that you do not 
want Workspace to fall back to the Common Platform hosted 
streaming servers. In this case, if the connection to all 
configured local server URLs fails, Workspace is unable to 
retrieve streaming data.  

By default, Workspace systematically attempts to connect to 
the Common Platform hosted streaming servers, if no local 
connection can be made. 

 
45  For further information, refer to PCN 13469 
46  HKEY_CURRENT_USER 
47  HKEY_LOCAL_MACHINE 

https://my.refinitiv.com/content/mytr/en/pcnpage/13469.html
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Setting Customization 

EIKON.STREAMING.API.LOCAL.DACS.APPLICATIONID This setting allows you to customize the DACS application 
ID, for Workspace it is 56 by default.  

CLIENTSSO_URL.ENABLED 

CLIENTSSO_URL 

Support Client SSO service to allow the user to use 
company credentials to login. 

Shortcuts 
There are two shortcuts created under the Refinitiv folder, found under the Start menu: 

− Refinitiv Workspace 

− Refinitiv Workspace - Excel 

Default folder structures 
The following table contains the default folder structures for User and Machine installations, 

and includes the location under which the structures are created: 

Service Location Structure 

User installation 

n/a %LocalAppData% ├───Refinitiv for Office 

│   └───1.20.68 

│       ├───config 

│       │       └───addin.config.json 

│       ├───Office_x64 

│       │       └───refinitiv-shim.dll 

│       └───Office_x86 

│                └───refinitiv-shim.dll 

├───Refinitiv Workspace 

│   │─── com.refinitiv.workspace.sessionsharing.json 

│   │─── install-settings.json 

│   │─── installInfo.json 

│   │─── Refinitiv-host.exe 

│   ├─── RefinitivWorkspace.exe 

│   ├─── locales 

│   ├─── resources 

│   └─── swiftshader 

├───Refinitiv Workspace Install Logs 

├───Refinitiv Workspace Logs 

├───Refinitiv Workspace.versions 

│   └───1.21.344 

└───Refinitiv Workspace.ToInstall 

    │───RFVWWindows_Core_1_21_276.zip 

    └───Extract 

%AppData% └───Refinitiv Workspace 

    ├─── Local State 

    └─── Cache 

Machine installation 

With auto-
update service 

%ProgramFiles% ├───Refinitiv for Office 

│   └───1.20.68 

│       ├───config 

│       │       └───addin.config.json 

│       ├───Office_x64 

│       │       └───refinitiv-shim.dll 

│       └───Office_x86 

│                └───refinitiv-shim.dll 

└───Refinitiv Workspace 

    ├───install-settings.json 

    ├───RefinitivWorkspace.exe 

    └───1.21.344 

        ├───com.refinitiv.workspace.sessionsharing.json 

        ├───installInfo.json 

        ├───Refinitiv-host.exe 

        ├───RefinitivWorkspace.exe 

        ├───RWupdaterService.exe 

        ├───locales 

        ├───resources 

        └───swiftshader 
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Service Location Structure 

%ProgramData% ├───Refinitiv Workspace 

│  ├───pmInstallInfo.json 

│  └───userInfo.json 

├───Refinitiv Workspace Install Logs 

├───Refinitiv Workspace.versions 

│    └───1.21.344 

└───Refinitiv Workspace.ToInstall 

      │───RFVWWindows_Core_1_21_276.zip 

      └───Extract 

%LocalAppData% └───Refinitiv Workspace Logs 

%AppData% └───Refinitiv Workspace 

    ├───Local State 

    └───Cache 

With auto-
update per 
user 

%ProgramFiles%\Refinitiv ├───Refinitiv for Office 

│   └───1.20.68 

│       ├───config 

│       │       └───addin.config.json 

│       ├───Office_x64 

│       │       └───refinitiv-shim.dll 

│       └───Office_x86 

│                └───refinitiv-shim.dll 

└───Refinitiv Workspace 

    ├───com.refinitiv.workspace.sessionsharing.json 

    ├───install-settings.json 

    ├───installInfo.json 

    ├───Refinitiv-host.exe 

    ├───RefinitivWorkspace.exe 

    ├───locales 

    ├───resources 

    └───swiftshader 

%ProgramData%\Refinitiv ├───Refinitiv Workspace 

│  ├───pmInstallInfo.json 

│  └───userInfo.json 

│ 

└───Refinitiv Workspace Install Logs 

└───Refinitiv Workspace.versions 

    └───1.21.344 

%LocalAppData%\Refinitiv ├───Refinitiv for Office 

│   └───1.20.68 

│       ├───config 

│       │       └───addin.config.json 

│       ├───Office_x64 

│       │       └───refinitiv-shim.dll 

│       └───Office_x86 

│                └───refinitiv-shim.dll 

├───Refinitiv Workspace 

│   ├───com.refinitiv.workspace.sessionsharing.json 

│   ├───install-settings.json 

│   ├───installInfo.json 

│   ├───Refinitiv-host.exe 

│   ├───RefinitivWorkspace.exe 

│   ├───locales 

│   ├───resources 

│   │   ├───app.asar 

│   │   ├───deployment.asar 

│   │   ├───package.zip 

│   │   ├───REFINITIVEXCEL.ico 

│   │   ├───REFINITIVMESSENGER.ico 

│   │   ├───REFINITIVWORKSPACE.ico 

│   │   ├───versionInfo.json 

│   │   └───app.asar.unpacked 

│   └───swiftshader 

├───Refinitiv Workspace Logs 

└───Refinitiv Workspace.ToInstall 

      │───RFVWWindows_Core_1_21_276.zip 

      └───Extract 

%AppData%\Refinitiv └───Refinitiv Workspace 

    ├───Local State 

    └───Cache 

%Temp% └───Refinitiv Workspace Uninstall Logs 

Without auto-
update service 

%ProgramFiles%\Refinitiv ├───Refinitiv for Office 

│   └───1.20.68 

│       ├───config 

│       │       └───addin.config.json 
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Service Location Structure 
│       ├───Office_x64 

│       │       └───refinitiv-shim.dll 

│       └───Office_x86 

│                └───refinitiv-shim.dll 

└───Refinitiv Workspace 

    ├───com.refinitiv.workspace.sessionsharing.json 

    ├───install-settings.json 

    ├───installInfo.json 

    ├───Refinitiv-host.exe 

    ├───RefinitivWorkspace.exe 

    ├───locales 

    ├───resources 

    └───swiftshader 

%ProgramData%\Refinitiv ├───Refinitiv Workspace 

│  ├───pmInstallInfo.json 

│  └───userInfo.json 

├───Refinitiv Workspace Install Logs 

└───Refinitiv Workspace.versions 

    └───1.21.344 

%LocalAppData%\Refinitiv └───Refinitiv Workspace Logs 

%AppData%\Refinitiv └───Refinitiv Workspace 

    ├───Local State 

    └───Cache 

%temp% └───Refinitiv Workspace Uninstall Logs 

Proxies  

Qualified Proxy 
Workspace is qualified with the following authenticated proxy: 

Proxy Authentication Method 

Squid 2.7 − No authentication 

− Basic 

− Digest 

− NTLM 

− Kerberos 

Squid 3.5.28 − Basic 

− Digest 

HTTP/1.1 (or above) Compliant Proxy  
Workspace requires HTTP/1.1. Workspace can attempt to use HTTP/2 but falls back to 

HTTP 1.1 if it is not viable.  

It is vital that you use an HTTP/1.1+ Compliant Proxy to have the best connection between 

the Workspace key station and the LSEG Platform on the head end.  

Important: The Streaming Service requires a keep alive or persistent connection, which is 
supported in the HTTP/1.1 specification. 



Appendix B: Software information and support 
 
 

LSEG Workspace Installation and Configuration Guide 

Document Version 124.02 

38 

Appendix B: Software information and 
support 

In this section 
− Documentation locations 

− Export control classification 

− Hosted connection item limits 

− About LSEG Workspace dialog 

− Data dictionary support 

− Local mode support 

Documentation locations 
Workspace technical content can generally be found in two locations: 

− The documentation section of the LSEG Workspace page. These documents are 
searchable using all popular search engines (such as Google or Bing). 

− Under the Workspace section of MyRefinitiv, the authenticated website. 

Where documents are to be found in other locations, these are provided in the table below: 

Documentation Location(s) 

Workspace Administration Panel 
Configuration 

A description of the functions of the Workspace Administration Panel can 
be found in the Configuration Guide. 

Workspace System Requirements The system requirements documentation can be found in the System 
Requirements document.  

LSEG Real-Time Data Access 
Control System (formerly DACS)48 

The DACS permission synchronization requirements can be found in the 
DACS Permission Synchronization Configuration Guide, under the DACS 
section of the authenticated website. 

LSEG Real-Time Advanced 
Distribution Server (formerly ADS)   

An overview of the ADS WebSocket connection configuration can be 
found in the ADS Software Installation Manual, under the Advanced 
Distribution Server (ADS) section of the authenticated website.  

LSEG Real-Time Advanced 
Distribution Hub (formerly ADH) 

Content covering the installation and configuration of the LSEG Real-
Time Advanced Distribution Hub can be found in the Advanced 
Distribution Hub section of the authenticated website. 

Financial Community Network 
(FCN) and Delivery Direct 

For further information about FCN and Delivery Direct, see the Private 
Network Overview section of the authenticated website. 

Chrome Extension For further information about the Google Chrome extension, see the 
Chrome Extension Installation Guide. 

Release Notes A summary of the features in the latest release of Workspace can be 
found in the Release Notes document. 

Service Description The Workspace Service Description document can be found in the 
Service Description document. 

Workspace Vendor Subservice 
Definitions 

A list of the Products, Exchanges, and Specialist Data definitions can be 
found in the Vendor subservice definitions document. These are 
managed using the LSEG Real-Time Data Access Control System 
(DACS). 

 
48 DACS Permission Synchronization for Workspace is recommended – rather than the DPRM service - to 
prevent misconfiguration or permission issues between the Refinitiv Data Platform and local LSEG Real-Time 
Distribution System (formerly TREP). 

While we recommend DACS, for information regarding the configuration of the DPRM service, refer to Appendix 
F: Settings. 

https://www.lseg.com/en/data-analytics/products/workspace#documentation
https://my.refinitiv.com/content/mytr/en/product/refinitiv-workspace.html
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/administration-panel-configuration-guide.pdf
https://www.refinitiv.com/content/dam/marketing/en_us/documents/support/workspace/system-requirements.pdf
https://www.refinitiv.com/content/dam/marketing/en_us/documents/support/workspace/system-requirements.pdf
https://my.refinitiv.com/content/dam/myrefinitiv/products/607/en/Technical/634430.pdf
https://my.refinitiv.com/content/mytr/en/product/data-access-control-system-(dacs).html
https://my.refinitiv.com/content/mytr/en/product/data-access-control-system-(dacs).html
https://my.refinitiv.com/content/mytr/en/product/real-time-advanced-distribution-server.html
https://my.refinitiv.com/content/mytr/en/product/real-time-advanced-distribution-server.html
https://my.refinitiv.com/content/mytr/en/product/real-time-advanced-distribution-hub.html
https://my.refinitiv.com/content/mytr/en/product/real-time-advanced-distribution-hub.html
https://my.refinitiv.com/content/mytr/en/policies/private-network-overview.html
https://my.refinitiv.com/content/mytr/en/policies/private-network-overview.html
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/chrome-extension-installation-guide.pdf
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/pre-release/release-notes-pr.pdf
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/service-description.pdf
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/vendor-subservice-definitions.pdf
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Documentation Location(s) 

Technical Roadmap A tabular summary of known significant changes to upcoming releases of 
Workspace can be found in the Technical roadmap document. 

 

Export control classification 
The following table contains export control classification details for Workspace: 

Program Name Refinitiv Workspace 

ICOS Reference 6420 

Program Version 1.x 

Sub-Products 6413 for Windows & 6414 for macOS 

 

ECCN (United States) EAR99 

ECCN (European Union) None 

Refinitiv Export Code NL 

Export Note This export code means ‘Not Licensable’ and is applied to items that 
can be exported ‘no license required’, under both EU and US 
regulations. Exports of NL items can be made to all countries except 
embargoed countries (Iran, Syria, North Korea, Cuba, or Crimea). 

US Commerce, BIS CCATS number self-classified 

 

Hosted connection item limits 
For the deployed desktop hosted connection, the Item limit is 2500. This can be extended to 

5000, with a fee-liable Product Line Item (PLI) add-on. 

Once the limit is reached, a message is displayed in the About LSEG Workspace > 

Streaming panel. 

About LSEG Workspace dialog 
The About LSEG Workspace dialog box provides information about the viewed Workspace 

installation and 

environment.  

To open the About 

LSEG Workspace 

dialog, In Workspace:  

− Click Help > About 
Refinitiv 
Workspace 

The dialog box divides 

information over five 

panels: 

− System Status 
contains Workspace 
version and variant 
information, 
together with 
service connection 

https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/workspace-and-eikon-technical-roadmap.pdf
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details and an overview of the computer on which this iteration of Workspace is running.  

− Streaming contains information about real-time data sources, including the primary feed 
used, RICs used49 (subscriptions), and any other feeds provided through a local LSEG 
Real-Time Distribution System. 

− User Details contains information about the currently logged in user, including their email 
address, their user unique identifier (UUID), job role, and location information. 

− Along with the proxy URL and version, the Data API Proxy panel also contains 
information about the status of the proxy, indicating whether it is available for external 
connections. 

− Services & Apps contains version information about services and apps that have been 
made available to the user. 

Data dictionary support 
Access to a Data Dictionary is only supported from a LSEG Real-Time Advanced Distribution 

Server (formerly ADS). 

Local mode support 
The Local Mode feature, as found in Eikon, is not supported. 

 

 
49  See the Hosted connection item limits section. 
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Appendix C: Command line statements  

In this section 
− Installation statements 

− Uninstallation statements 

− Configuration Manager parameters 

− Workspace executable statements 

Installation statements 
The table below list command line statements that can be 

used to install Workspace: 

Installation mode Command 

Base commands  

User 50 RefinitivWorkspace-installer_x.xx.xx.exe --user  

Machine  RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-peruser 

Machine without Auto-Update RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-no 

Machine with Update Service RefinitivWorkspace-installer_x.xx.xx.exe –-machine-autoupdate-service 

SSO  RefinitivWorkspace-installer_x.xx.xx.exe --client-sso=<client SSO URL> 

Installation help page RefinitivWorkspace-installer_x.xx.xx.exe --help 

Run Messenger only RefinitivWorkspace-installer_x.xx.xx.exe --messengeronly 

Shared configuration 51 52  

Additional parameter --sharedconfig="<file path>" 

Failover --sharedconfig="<file path-1>";"<file path-2>";"<file path-3>" 

 

Uninstallation statement 
The table below list command line statements that can be used to uninstall Workspace: 

Command 

RefinitivWorkspace.exe --uninstall  

 

Configuration Manager parameters 
The table below list command line statements that can be used to configure Workspace: 

Installation mode Command 

User "<InstallDir>\Refinitiv\Refinitiv Workspace\RefinitivWorkspace.exe"  

--config-manager  

Machine or Hot-Desking "<InstallDir>\Refinitiv\Refinitiv Workspace\RefinitivWorkspace.exe"  

--config-manager --machine 

 

 
50  This is the default method of installing Workspace. As such, the –-user parameter is not a requirement. 
51  For example, RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-peruser --sharedconfig="<file 

path>" is the command line for a machine installation with a shared configuration. 
52  The content of the file(s), identified by the --sharedconfig parameter, could change from version-to-version. So, 

refer to the appropriate documentation for amendments to this parameter when there is a new release. 

R E L A T E D  L I N K S  

− Performing an installation 
using your Single Sign On 
URL 
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Workspace executable statements 
There are various parameters you can add to the Workspace executable, located in the 

%ProgramFiles%\Refinitiv\Refinitiv Workspace\<version>\ folder.  

The command line structure is: 

RefinitivWorkspace.exe <Parameter> 

For example: 

RefinitivWorkspace.exe –-connection=internet 

The following parameters are available: 

Parameter Purpose 

--clearCache   Clear the Electron cache of Workspace 

--clearLogs Clear the logs folder of Workspace 

--clearRememberMe   Delete the automatic login cookie 

--client-sso=<url> Set the URL for your SSO 

--dumpApps Dump available Apps of Workspace into the logs folder 

--dumpConfig Dump the configuration of Workspace into the logs folder 

--excel    Start Excel with the Workspace ribbon add-in 

--log-level=<level> Set the level of detail for log files, where <level> is: 

− error 

− warning 

− information 

− verbose 

− debug 

--resetCache Reset the product cache of Workspace to its default state 

--systemtest    Run the embedded System Test 53 

--uninstall Uninstall Workspace 

--update-office-registry=<value> Used to update the office registry key, where <value> is either HKLM or 
HKCU. 

For further information, see Excel add-in loading issue. 

--upload-logs Upload log files 

--version Show the version of Workspace 54 

--versions Display the version of underlying components of Workspace, for 
example:  
--versions=electron, node (or simply --versions)  

--nofile    Start system tray icon only 

 

Installer command line statements 
Currently, only the following command line statement is available, which enables Workspace 

to run at a higher processing priority: 

RefinitivWorkspace-installer_x.xx.xx.exe --run-above-normal-priority 

 
53  For further information regarding the System Test applications, refer to the Workspace System Test Guide. 
54  On macOS, for this command to work as intended, go to the /Applications/Refinitiv 

Workspace.app/Contents/MacOS folder and run the command, ./RefinitivWorkspace --args --version. 

https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/pre-release/system-test-guide-pr.pdf
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Appendix D: Automatic update 
workflow 

The content in this appendix applies to the following installation types: 

− --user  

− --machine-autoupdate-peruser 
55  

− --machine-autoupdate-service  

The --machine-autoupdate-no installation mode is not discussed, as automatic update 

functionality is disabled for that mode. 

Device and installation registration 
1. Login into Workspace 

2. During the first minute after login, RefinitivWorkspace.exe retrieves installationGUID 

from installinfo.json.  

− If installationGUID is not found in installinfo.json, it is created using guid.json 
56 

− If installinfo.json does not exist, it is created automatically 

− Depending on the installation method, installinfo.json is in one of the following 
locations: 

Method Location 

User C:\Users\%Username%\AppData\Roaming\Refinitiv\Refinitiv Workspace\ 

Machine with auto update per user <install path>\Refinitiv\Refinitiv Workspace\ 

Machine with auto update service %programdata%\Refinitiv\Refinitiv Workspace\ 

 

3. RefinitivWorkspace.exe sends a request to Desktop Deployment Portal to do the 

following: 

a. Check whether the device is registered on Desktop Deployment Portal and, if not, add 

the new device  

b. Add a login history record 

Checking new version availability 
Randomly, between 5-60 minutes after login, RefinitivWorkspace.exe checks 

57 the 

availability of the new target version for the current user.  Version checks are then scheduled 

daily, at 00:<randomMinutes>. 

4. Checks the new version with Admin Panel58 

5. Checks the new version with Desktop Deployment Portal 

 

 
55  For --machine-autoupdate-peruser mode only: To update the master installation automatically (bulk 

autoupdate), the administrator should get the latest version and reinstall Workspace. All users, that have a 
lower version than the master installation, are updated to the new version of master installation automatically, 
with the active setup, once they log off from Windows, and log in again. 

56  Guid.json is located under C:\Users\%Username%\AppData\Roaming\Refinitiv\Refinitiv Workspace\ 
57  This check can also be triggered by opening the About Box. 
58  For further information, see the Administration Panel Configuration Guide. 

https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/administration-panel-configuration-guide.pdf


Appendix D: Automatic update workflow 
 
 

LSEG Workspace Installation and Configuration Guide 

Document Version 124.02 

44 

Changing the update time 
To change update time after login, use the command --checkupdateTime=<n>, where: 

− --checkupdateTime=0 – Checks for a new version instantly after login 

− No parameter set – Checks for a new version randomly between 5-60 minutes after login 

Setting up a custom scheduler 
To set up a custom scheduler to check for new versions, use the command:  

--autocheckupdatetime=<a> <b> <c> <d> <e> 

Where: 

<a>  Day of week (0 – 7, where 7 is Sunday). You can also use names, that is, 

Monday, and so on. 

<b>  Month (1 - 12) 

<c>  Day of month (1 - 31) 

<d>  Hour (0 - 23) 

<e>  Minute (0 - 59) 

For example, for an update check to be performed every Sunday, at 5:30 PM, use the 

command: 

 --autocheckupdatetime=7 * * 17 30 

If a new version is detected see the next steps. 

Downloading a version and preparing for 
upgrade 
1. Workspace receives the target version information (including URL) and automatically 

downloads the zipped package. 

Calling process  RefinitivWorkspace.exe 

URL   
https:\\cdn.refinitiv.net\public\packages\RFVWWindows\RFVWWi

ndows_Core_x_xx_xxx.zip  

Installation type Download location 

--user 

%AppData%\Local\Refinitiv\Refinitiv Workspace.ToInstall 

--machine-autoupdate-peruser 

--machine-autoupdate-service %programdata%\Refinitiv\Refinitiv Workspace\Refinitiv Workspace.ToInstall 

 

2. Workspace extracts the files from the zipped file to a newly created Extract folder  

Calling process  RefinitivWorkspace.exe 

Unzip tool  yauzl node_module 59  

Extract location <Download location>\Extract 

 
59  https:\\www.npmjs.com\package\yauzl 

https://cdn.refinitiv.net/public/packages/RFVWWindows/RFVWWindows_Core_x_xx_xxx.zip
https://cdn.refinitiv.net/public/packages/RFVWWindows/RFVWWindows_Core_x_xx_xxx.zip
https://www.npmjs.com/package/yauzl
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Checking new package with Desktop 
Deployment Portal 
1. Checks whether the content in the Extract\checkUpdateInfo.json matches the 

content received from the Desktop Deployment Portal (by checking the file hash code):  

If… Then…  

Yes  Skip downloading the new package and wait for the upgrade initiation 

No Delete the downloaded package and Extract folder 

 

2. Download the new package, with the updated Extract\CheckUpdateInfo.json 

content (see Downloading a version and preparing for upgrade) 

Initiating an update 
1. The persons required to perform this step depend on the installation type: 

Installation type Performed by 

--user The user of the machine where Workspace was installed 

--machine-autoupdate-peruser Each Workspace user on the machine where the application was 
installed 

--machine-autoupdate-service Any user of the machine(s) where Workspace was installed 

  

− To begin the upgrade, do one of the following: 

− Select the Help menu, choose About Refinitiv Workspace, and click the Upgrade 

now button. 

− Select the Refinitiv Workspace menu and choose: 

− Sign Out, or 

− Exit Refinitiv Workspace 

2. RefinitivWorkspace.exe runs an Extract\setup.exe command, with arguments 

based on setupArgs, defined in CheckUpdateInfo.json.  

Installation type Example command 

--user setup.exe --update --rerun --silent --forceInstall --calledByCheckupdate 

--execute=RefinitivWorkspace.exe --appLocation= 

C:\\Users\\%Username%\\AppData \\Local\\Refinitiv\Refinitiv Workspace --machine-autoupdate-peruser 

--machine-autoupdate-service 

setup.exe --update --rerun --silent --forceInstall --calledByCheckupdate 

--execute=RefinitivWorkspace.exe -- appLocation=C:\\Program 

Files\\Refinitiv\Refinitiv Workspace\\1.19.447 

−  

Upgrade workflow 
The following actions are performed by Extract\Setup.exe: 

1. Waits for several seconds until RefinitivWorkspace.exe is terminated 
60 

2. Performs a backup of installation folders, based on the information in the files section 

of InstallInfo.json 

 
60  If RefinitivWorkspace.exe has not been terminated, Setup.exe force-kills the process.  

 For --machine-autoupdate-service mode: Only the instigating user is required to terminate their Workspace 
session.   
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a. --machine-autoupdate-service only: Checks whether Workspace is in use by 

another user:  

If… Then… 

Yes Go to step 2.c. 

No Go to step 2.b. 

 

b. Backs up the Workspace installation folder: 

Installation type Installation folder Backup location 

--user 

Refinitiv Workspace <install_path>\Refinitiv Workspace.Backup 

--machine-autoupdate-peruser 

--machine-autoupdate-service Workspace <Version> 
<install_path>\Refinitiv\Refinitiv 

Workspace\<Version>.Backup 

 

c. --machine-autoupdate-service mode only: Checks whether Microsoft Office is in 

use by another user on the same machine: 

If… Then… 

Yes Go to step 2.e. 

No Go to step 2.d. 

 

d. Backs up the Refinitiv for Office installation folder: 

Installation type Installation folder Backup location 

--user Refinitiv for 

Office 
<install_path>\Refinitiv for Office.Backup 

--machine-autoupdate-peruser 

--machine-autoupdate-service Office <Version> <install_path>\Refinitiv for Office\<Version>.Backup 

 

e. --machine-autoupdate-service mode only: Performs a backup of the Update 

Service installation folder:  

Installation type Installation folder Backup location 

--machine-autoupdate-

service 

Update Service 

<Version> 

<install_path>\Refinitiv Workspace Update 

Service\<Version>.Backup 

 

3. Backs up the shortcuts folder, based on the information in the shortcutsFolder 

section of InstallInfo.json:  

Installation type Backup location 

--user %appdata%\Refinitiv\Refinitiv Workspace\Backup\<randomname>-

backupShortcut\ --machine-autoupdate-peruser 

--machine-autoupdate-service 
%programdata%\Refinitiv\Refinitiv Workspace\Backup\<randomname>-

backupShortcut\ 

 

4. Creates new folders and installs files: 

Installation type Workspace location Office location Update Service location 

--user 

<install_path>\Refinitiv 

Workspace 
<install_path>\Refinitiv 

for Office 
n\a --machine-autoupdate-

peruser 

--machine-autoupdate-

service 

<install_path>\Refinitiv 

Workspace\<Version> 

<install_path>\Refinitiv 

for Office\<Version> 

<install_path>\Refinitiv Workspace 

Update Service\<Version> 

 

5. Installs shortcuts: 

Installation Type File location 

--user %AppData%\Microsoft\Windows\Start Menu\Programs\Refinitiv 

--machine-autoupdate-peruser − %AppData%\Microsoft\Windows\Start Menu\Programs\Refinitiv  

− %ProgramData%\Microsoft\Windows\Start Menu\Programs\Refinitiv  

--machine-autoupdate-service %ProgramData%\Microsoft\Windows\Start Menu\Programs\Refinitiv 
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6. Installs Add Remove Programs (ARP) registry entries for Workspace 

7. Checks whether Workspace was installed with –messengeronly parameter: 

If…   Then…  

Yes  Go to step 9 

No Go to step 8 

 

8. Installs Office Registry and Office Add-ins 

9. Creates install-settings.json, containing settings for Microsoft Office, providing the 

location for Workspace and Office add-ins: 

Installation Type File location 

--user 

<install_path>\Refinitiv\Refinitiv Workspace\ 

--machine-autoupdate-peruser 

--machine-autoupdate-service <install_path>\Refinitiv\Refinitiv Workspace\<version> 

 

10. Creates com.refinitiv.workspace.sessionsharing.json, providing Chrome 

extension settings and the location of the Refinitiv-host.exe file: 

Installation Type File location 

--user 

<install_path>\Refinitiv\Refinitiv Workspace\ 

--machine-autoupdate-peruser 

--machine-autoupdate-service <install_path>\Refinitiv\Refinitiv Workspace\<version> 

 

11. Checks whether the installation was completed successfully: 

If…   Then…  

Yes  Removes backup folders 61 

No 
Removes all newly installed files and restores backup folders. 

Ends the installation with an error message. 

 

12. Creates InstallInfo.json, in a mode-specific location, and writes new installation 

information, such as installation paths, shortcut paths, and so on: 

Installation Type File location 

--user 

<install_path>\Refinitiv\Refinitiv Workspace\ 

--machine-autoupdate-peruser 

--machine-autoupdate-service <install_path>\Refinitiv\Refinitiv Workspace\<version> 

 

13. If the update was triggered by signing out, it relaunches Workspace with --startApp  

 

 
61  For the machine-autoupdate-service only: If Workspace is in use at the time of update, the previous <Version> 

folders under Refinitiv Workspace and Refinitiv for Office are preserved. Once all users have logged out of 
their devices and logged in again, access to the new Workspace version is facilitated using Active Setup. 
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Appendix E: Settings 

In this section 
− Networking 

− Microsoft Office settings 

− Security 

Networking 

Ports  
Workspace uses the following connections: 

API 62 Connection Port 63 

Desktop Data API http:\\localhost:9000\api\ 9000 

Side by Side API 64 http:\\localhost:9000\sxs\ 9000 

Refinitiv Workspace Bus http:\\localhost:49152\ 49152 

 

Communication protocols 
Protocol Port Number  Workspace Services Required For 

TCP 1024+ → 443 

1024+ ← 443  

LSEG Workspace 
Platform 

Administration Services 

View Service 

Search & Navigation Service 

Time Series Service 

Workspace Messenger Service, 

Trading Service 

Update Service 

Thomson Reuters Remote Support (TRRS) 

Datastream Service 

Newscasts (internet only) 

FXall 

Flextrade Spark 

Real-Time Data  

TCP 1024+ → 15000 

1024+ ← 15000 

Real-Time Data LSEG Real-Time Advanced Distribution Server (formerly 
ADS) 

TCP\UDP 1024+ → 53 

1024+ ← 53 

DNS Server Domain Name Resolution from Domain Name Server 

 

Services  
This section summarizes the services and features related to connectivity and provides links 

to further information.  

 
62  You can find further information regarding APIs on the Developer Community website. 
63  9000 and 49152 are internal ports. If the port is already in use, Workspace increments until a free port number 

is found:  

− for Desktop Data and Side by Side, from 9000, and 

− for Workspace Bus, from 49152 
64  For further information, see Workspace Web Side by Side API on the Developer Community website. 

https://developers.lseg.com/en
https://developers.refinitiv.com/en/api-catalog/eikon/workspace-web-side-by-side-api/documentation
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Financial Community Network and Delivery Direct  

To access new AWS service endpoints, customers using a private network must whitelist the 

following new IP addresses, which impact Delivery Direct, FCN, and CMC users: 

− 159.43.192.0/23 (AMERS) 

− 159.43.200.0/23 (EMEA) 

− 159.43.208.0/23 (APAC) 

For further information about Finance Community Network (FCN) and Delivery Direct, see 

the Private Network Overview section of the authenticated website, containing the following 

documents: 

− Customer Connectivity DNS Migration Guide 

− FCN Customer Connectivity Guide 

Internet 

LSEG will not divulge IP address information under any circumstances. Doing so prevents us 

from changing IP addresses, as and when needed, without a notification period. These IP 

addresses may not always be under our direct control. 

Transport Layer Security protocol 

From 01 June 2023, to continue to use LSEG Real-

Time services, you must ensure that use of TLS 

version 1.2 is enabled for all Workspace users.  

To enable TLS 1.2: 

1. In Windows, click Start 

2. Open the Control Panel app and choose 

Network and Internet 

3. In the Network and Internet panel, choose 

Internet Options 

4. In the Internet Properties dialog, shown opposite, 

select the Advanced tab 

5. Scroll to the Security section (at the end of the 

settings list) and select Use TLS 1.2 

For further information, refer to PCN205244-Change 

in supported TLS protocols for Eikon and 

Workspace. 

Web hosted services  

The following services and features are accessed through the Internet and not reached 

through a private network: 

MyRefinitiv (my.refinitiv.com) The authenticated documentation repository. 

Contact Us For raising questions, issues, and other topics. 

Desktop crash dump upload utility 
Sends data to the LSEG support platform. This is in case a user has a 
session crash. The crash data is sent from the user session to Refinitiv, 
so we can investigate the crash. 

https://my.refinitiv.com/content/mytr/en/policies/private-network-overview.html
https://my.refinitiv.com/content/mytr/en/product-notifications/details.html?id=PCN205244
https://my.refinitiv.com/content/mytr/en/product-notifications/details.html?id=PCN205244
https://my.refinitiv.com/content/mytr/en/product-notifications/details.html?id=PCN205244
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GetSupport or interactive Chat 
Where feedback / support issues are logged, and you can establish a 
chat dialogue with an agent. 

Messenger Traffic  All traffic will be over internet, by default. 65 

Portal SDK starter kit 
(cdn.refinitiv.com) 

Software Development Kit (SDK) is a toolkit that you can use to interact 
with the app and our platform. This is hosted on CloudFront. 

Chrome Extension 
This is accessed from an external web site, either by the user going to 
the Google store, or through enterprise set-up.  

 

Content filtering domains 
You need to whitelist the domains for content that can be accessed through Workspace. 

Important: Third Party apps in Workspace may require access to specific domains. For 
information about specific access requirements, it is advisable to contact the app 
developer directly.  

Example domain list 

The following list of domains is not exhaustive and is for illustrative purposes only. 

 Many of the domains listed in the table below are wildcard values, where a subdomain 

may prepend and/or append the listed domain. 

DNS Workspace services 

autex.com 

autexnow.com 
Autex 

authenticator.pingone.com 

idpxnyl3m.pingidentity.com 
Multi-factor Ping Authenticator app 

bit.ly 

reut.rs 

tmsnrt.rs 

Bit.ly Integration Information 

trmcs-documents.s3.amazonaws.com Central Bank Polls 

session.rservices.com Contribution address, News documents 

cnbc.com 

ft.com 

moodys.com 

Miscellaneous external content 

googleapis.com Google 

chrome.google.com Workspace Chrome Extension 

virtualearth.net 

thomsonreuters.wdtinc.com 
Interactive Map 

lipperweb.com Lipper Market Insight 

loanconnector.com Loan Connector 

loanpricing.com Loan Pricing 

depth.finance Market Depth 

cdn.mathjax.org MathJax JavaScript display engine 

storage.tr.191.it 

thomsonone.com 

ws.platts.com 

News Documents 

reuters.com 

breakingviews.com 
News URL link 

 
65  This is not the case when private line connectivity is enabled for Workspace Messenger. For further 

information, see Appendix E: Workspace Messenger standalone. 
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DNS Workspace services 

refinitiv.com 

refinitiv.net 

refinitiv.biz 

thomsonreuters.com 

thomsonreuters.net 

thomsonreuters.biz 

LSEG 

globalrelay.com Workspace Messenger Compliance 

salesforce.com 

webtrendslive.com 
Refinitiv Migration Tools 

kaltura.com 

reuters.tv 

vmnd.tv 

Newscasts (formerly Reuters Insider) 

cxvid-livecapture.s3.amazonaws.com Newscasts (formerly Reuters Insider): Recording Video and Images 

thomson.112.2o7.net 
Newscasts (formerly Reuters Insider): Analytics and user interaction 
reporting 

gstatic.com 

apis.google.com 

bv-predictions2021.com 

cloudfront.net 

google-analytics.com 

googletagservices.com 

product.datastream.com 

themes.googleusercontent.com 

trust.org 

views.rkd.reured.com 

Reuters Interactive graphics 

bing.com Search engine 

media-server.com Street Event content 

comodo.com TLS/SSL Client Certificate (HTTPS) 

tradeweb.com Tradeweb 

fxall.com Trading Service 

pbs.twimg.com 

twitter.com 
Twitter integration 

wom.finance Wealth Order Management 

awsglobalaccelerator.com  

avatars.stocktwits.com Social Media Monitor 

img.en25.com 

eloqua.com 
LSEG Training 

salesforceliveagent.com Support 

oneaccess.io OneAccess 

dtn.com Weather layers in InteractiveMap app 

 

Trusted root certification  
You can download and verify the COMODO certificate from the appropriate location, defined 

in the table below: 

Internet https:\\cipher-test.refinitiv.com\  

Private network  https:\\cipher-test.extranet.refinitiv.biz\ 

 

Certificate details: 
 

Issued by CN O C 

COMODO COMODO RSA 
Certification Authority 

COMODO RSA 
Certification Authority 

COMODO CA Limited GB 

https://cipher-test.refinitiv.com/
https://cipher-test.extranet.refinitiv.biz/
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Microsoft Office settings 

Workspace for Excel VSTO add-in 
For the Microsoft Excel Visual Studio Tools for Office (VSTO) add-in, Workspace installs a 

single DLL file under the Windows operating system, refinitiv-shim.dll. This supports 

the core features of the Refinitiv Workspace - Excel (Workspace ribbon) add-in. 

MS Office File location 

32-bit <Install_path>\Refinitiv\Refinitiv for Office\x.x.x\Office_x86 

64-bit <Install_path>\Refinitiv\Refinitiv for Office\x.x.x\Office_x64 

 

There is no linking, presentation tools, or deal analytics package. 

Workspace add-in 
The Refinitiv Workspace - Excel (Workspace ribbon) add-in changes are listed in the table 

below: 

Version Add-ins 

1.22 No changes 

1.21 =RDP.FxSwpToSwp() 

=RDP.FxDepToSwp() 

=RDP.FxSwpToDep() 

=RDP.FxSpot() 

=RDP.FxInfo() 

=RDP.FxZcToFra()  

=RDP.DateAdjToWD() 

=RDP.DateCountPeriods() 

=RDP.DateFindDate() 

=RDP.DateIsWD() 

=RDP.DateLastWD() 

=RDP.DateListHolidays() 

=RDP.Adinterp() 

1.20 No changes 

1.19 No changes 

1.18 No changes 

1.17 No changes 

1.16 =RDP.Publish() 

=RtContribute()66 

=RDP.PublishChain() 

=RtContributeChain() 

=DSCHART() 

1.15 No changes 

1.14 No changes 

1.13  No changes 

1.12 =TRAggregate() 
=RDP.Aggregate() 
=RDP.Analytics() 
=RDP.Data() 
=RDP.HistoricalPricing() 
=RDP.Price() 

1.11 =RDP.Today() 
=RDP.Now() 

1.10 =RtToday() 
=RtNow() 

 
66  See Contributions (RtContribute) in the Known issues section. 
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Version Add-ins 

1.9 Refinitiv.EmbeddedApplication (financial chart) 

=DSGRID() 
=Thomson.Reuters.AFOSpreadSheetFormulas.DSGRID() 
=RDP.Search() 

1.8 =RHistory() 
=RtGet() 
=TR() 

Customer managed over Internet 
Customer managed over Internet mode is a sub deployment, where Workspace connects the 

real time data on a user’s own local LSEG Real-Time Distribution System (formerly TREP) 

infrastructure, while other content is sourced from the Refinitiv Data Platform, through the 

Internet. 

To configure this:  

1. In Workspace, open Configuration 

Manager. 

2. In the Network panel, under 

Connection Type, select Internet. 

3. In the Streaming panel, under 

Streaming Data Retrieval, select 

From a local LSEG Real-Time 

Advanced Distribution Server (ADS).  

4. This opens three separate panels – 

Servers, Feeds, and DACS – where 

you can add your server and feed 

information.  

Security 

FIPS 
Workspace is not supported in a 140 series Federal Information Processing Standards 

(FIPS) environment.  

User Agent 
A User Agent is an application that retrieves and presents Web content for users or is 

implemented using Web technologies.  

Workspace identifies connections to the ADS User Agent. For example, this could contain 

the following string and version:  

RFV-Workspace\<version> 

Where the <version> is updated to match the Workspace executable version. 
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Enabling the DPRM service 
Important: In Workspace 1.23, there is a known issue with the DPRM service that affects 
a small minority of installations. This has been fixed in Workspace 1.24. 

For those Workspace desktop customers who want to use the optional DPRM service in their 

local LSEG Real-Time Distribution System, the settings in the following table can be added 

to the <override_settings>.json file. 

Setting Description 

EIKON.STREAMING.API.LOCAL.DACS.DPRM.PORT 67 This allows you to specify the port to use to retrieve the 
entitlements used for DPRM.  

In general, the port should be set to either of the following 
modes68:  

− 8261 - Permission proxy mode, or        

− 8302 - Permission service mode69 

EIKON.STREAMING.API.LOCAL.DACS.DPRM.INTERVAL This allows you to set the interval, in milliseconds, between 
each reconciliation of DACS entitlements with the DPRM 
service.   

Default value: 86400000 (24 hours). 

EIKON.STREAMING.API.LOCAL.DACS.DPRM.DELAY This allows you to set the delay, in milliseconds, between 
Workspace initialization after login and the reconciliation of 
DACS entitlements with the DPRM service.  

Default value: 60000 (60 seconds). 

EIKON.STREAMING.API.LOCAL.DACS.DPRM.SERVERS This parameter is used when running permission service 
mode only. 

This allows you to specify a list of servers to use for DPRM 
and should be set for permission service mode only (port 
8302).70 

This setting is defined as a JSON-encoded array of 
permission service hostnames. For example:  

"[\"dacs01\",\"dacs02\",\"dacs03\"]"  

DPRM settings example 
"EIKON.STREAMING.API.LOCAL.DACS.DPRM.PORT": "8261", 

"EIKON.STREAMING.API.LOCAL.DACS.DPRM.INTERVAL": "43200000",                

"EIKON.STREAMING.API.LOCAL.DACS.DPRM.DELAY": "50000",  

"EIKON.STREAMING.API.LOCAL.DACS.DPRM.SERVERS": 

"[\"dacs01\",\"dacs02\",\"dacs03\"]" 

Important: DACS Permission Synchronization for Workspace is recommended – rather 
than the DPRM service - to prevent misconfiguration or permission issues between the 
Refinitiv Data Platform and local LSEG Real-Time Distribution System (formerly TREP). 

 
67  The EIKON.STREAMING.API.LOCAL.DACS.DPRM.PORT parameter is mandatory. 
68  If not set to one of these values, DACS synchronization is not performed. 
69  In permission proxy mode, the list of servers in the EIKON.STREAMING.API.LOCAL.SESSIONS setting is used. 
70  If not set, the list of servers defined in the EIKON.STREAMING.API.LOCAL.SESSIONS setting is used. 
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Appendix F: Shared configuration files  

Configuration override order 
The illustration below shows the override order for configuration settings, where commands 

issued using the command line have the highest level of priority: 

 

Creating a shared configuration file 
 The Admin level shared configuration file is created using the Administration Panel tool. 

For further information, refer to the 

Administration Panel Configuration 

Guide.  

Once you have made your settings using 

the Configuration Manager dialog, do the 

following: 

1. click Export  

2. Use the Save As dialog to define the 

file name and location 

C
O

N
F

I
G

U
R

A
T

I
O

N
 

COMMAND LINE 
Command line statements 

Company configuration 

Admin configuration 

User details 

settings 

User settings  
(JSON file) 

Machine settings  
(JSON file) 

Default settings 

SHARED 

PLATFORM 

LOCAL 

Product 

settings 

User 

settings 

https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/administration-panel-configuration-guide.pdf
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/administration-panel-configuration-guide.pdf
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Settings 
The following table contains a shared configuration file example, showing where the setting 

is found, and the selection or entry that was made in the example: 

Setting example Description\Source 

{  

Configuration Manager > Network menu  

"EIKON.CONNECTION.MODE": "private", Options:  

− Internet 

− Private network  

Configuration Manager > Advanced menu   

"REFINITIV.WORKSPACE.RUN_ABOVE_NORMAL_PRIORITY": 

"true", 

Option: 

− Run at the Highest Available Process Priority 

Level  

Configuration Manager > Printer menu   

"REFINITIV.WORKSPACE.TRADING.PRINTER_NAME": 

"Microsoft Print to PDF", 

Options: 

− Configured printers71 

− Fax 

− Microsoft Print to PDF  

− Microsoft XPS Document Writer 

− OneNote (Desktop) 

− OneNote for Windows 

Configuration Manager > Shared Configuration menu 

"EIKON.INTRANET_OVERRIDE.ENABLED": "true", Options: 

− Use a shared configuration 

"EIKON.INTRANET_OVERRIDE.URL": "C:\\RWTest\\Shared 

config\\MAIN.json", 

− Location path or URL (defined as 

C:\\RWTest\\Shared config\\MAIN.json) 

− This can be multiple location paths or URLs, 

delimited using a semi-colon (;) 

Configuration Manager > Client SSO menu  −  

"CLIENTSSO_URL.ENABLED": "true", Options: 

− Use a client SSO  

"CLIENTSSO_URL": "https:\\myapps.testsso.com", − Thomson Reuters (defined as 

https:\\myapps.testsso.com) 

"CLIENTSSO_REFINITIV_URL": 

"https:\\myapps.testsso.com", 

− Refinitiv (defined as 

https:\\myapps.testsso.com) 

Configuration Manager > Streaming menu  −  

"EIKON.STREAMING.API.LOCAL.ENABLE": "true", Stream Data Retrieval options: 

− From Refinitiv 

− From a local LSEG Real-Time Advanced 

Distribution Server (ADS)   

"EIKON.STREAMING.JETQUOTES.DESKTOP.CONFLATION.ENABLE

": "true", 

Streaming Conflation option: 

− Activate Conflation Rate 

"EIKON.STREAMING.JETQUOTES.DESKTOP.CONFLATION": 

"3000", 

− Conflation rate value drop down (3 seconds 

selected) 

Configuration Manager > Streaming > Servers menu72 

"EIKON.STREAMING.API.LOCAL.SESSIONS": 

"[\"wss:\\test-ads-

sharedconfig.com:15000\WebSocket\"]", 

LSEG Real-Time Advanced Distribution Server 
(formerly ADS) options: 

− Protocol (selected wss:\\) 

 
71 Network or connected directly 
72  Up to eight additional servers can be configured. For further information, refer to the Configuring multiple 

servers section. 
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Setting example Description\Source 

− Hostname or IP (defined as test-ads-

sharedconfig.com) 

− Port (defined as 15000) 

For additional servers that may be configured in the 
shared configuration file only, see the Alternative 
streaming servers section, below. 

Configuration Manager > Streaming > DACS menu   

"EIKON.STREAMING.API.LOCAL.DACS.USERNAME": 

"permit_all_exchanges", 

Options: 

− Username (defined as permit_all_exchanges) 

"EIKON.STREAMING.API.LOCAL.DACS.POSITION": 

"%USERDETAILS.LASTNAME%_%USERDETAILS.UUID", 

− Position (defined as 

%USERDETAILS.LASTNAME%_%USERDETAILS.UUID) 

Configuration Manager > Streaming > Feeds menu  

"EIKON.STREAMING.API.LOCAL.DEFAULTSOURCE": 

"IDN_RDF_2", 

Main Feed options: 

− Feed Name (defined as IDN_RDF_2) 

− Key Letter(s) 

− Alias(es) 

"EIKON.STREAMING.API.LOCAL.DESKTOP.ALIASES”: 

“{\”Test Internal feed 1\”:[\”Z\”]}”, 

Other Local Feeds options: 

− Feed Name (defined as Test Internal feed 1) 

− Key Letter(s) (defined as Z) 

"EIKON.STREAMING.API.LOCAL.DESKTOP.ALIASES”: 

“{\”Test Internal feed 1\”:[\”INF_1\”]}”, 

− Feed Name (defined as Test Internal feed 1) 

− Alias(es) (defined as INF_1) 

“EIKON.STREAMING.API.LOCAL.DISABLEDCONTRIBUTIONSOURC

ES”: "[\"ATS_GLOBAL_1\",\"NO_CONTRIB_ALLOWED\"]"73 

By default, contribution is allowed on all sources. 
This setting is used to list sources on your local 
LSEG Real-Time Advanced Distribution Server 
where contributions are not allowed. 

Any subsequent attempt to contribute data to one of 
the listed sources is then rejected. 

This setting should be defined to a JSON-encoded 
array, where each array entry is a real source 
name. For example: 

["ATS_GLOBAL_1","NO_CONTRIB_ALLOWED"] 

Configuration Manager > Other menu   

"EIKONPROTOCOL.ISDEFAULTAPPLICATION": "true" Select the app that is used to open LSEG links: 

− LSEG Workspace  

− Eikon 4 

}  

 

For further information on the creation of a shared configuration file, refer to the Configuring 

Workspace section. 

Alternative streaming servers 
In Workspace 1.22 

74, additional Refinitiv Wire Format protocols for LSEG Real-Time 

Advanced Distribution Server may be configured in your shared configuration JSON file 
75:  

Protocol 76 Transport Example 

rwf+ws:\\ WebSocket rwf+ws:\\ads01.example.com:15000\WebSocket 

rwf+wss:\\ Secure WebSocket rwf+wss:\\ads01.example.com:443\WebSocket 

 

 
73  This feature becomes available at the beginning of August 2023. 
74  Workspace version 1.22 is the first release to support the new protocols and some features still use the 

WebSocket protocol instead of the new Refinitiv Wire Format protocols. 
75  These server options will be added to the Configuration Manager in a future version of Workspace. 
76  LSEG Real-Time Advanced Distribution Server version 3.7 is required for rwf+ws and rwf+wss.  
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To retrieve streaming data, Workspace attempts connection with the first of the provided 

URLs. If the connection fails, Workspace tries each defined URL until it succeeds. For 

example: 

["ws:\\ads01.example.com:15000\WebSocket","rwf+wss:\\ads02.example.com:4

43\WebSocket"] 

Protocol support 
The new protocols are currently supported for use through your Local LSEG Real-Time 

Distribution System only. Refer to the following table for a summary of planned protocol 

support: 

Connection ws wss rwf+ws rwf+wss 

Local Real-Time Distribution System - - - - 

Hosted Market Data System - - - - 

Refinitiv Contributions Channel - - - - 

 

Where: 

 Supported 

 Supported but requires LSEG Real-Time Advanced Distribution Server version 3.7 

 Supported in a future release of Workspace 
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Appendix G: Workspace Messenger  

Standalone 

Workspace Messenger private line connectivity  
You can use Workspace Messenger to send and receive text messages, photos, and stock 

prices. 

Once you have installed Workspace Messenger, if you require connectivity through a Private 

Line, do the following: 

1. Navigate to the Refinitiv Workspace shortcut: 

a. Click Start  

b. Scroll to Refinitiv > Refinitiv Workspace 

c. Right-click Refinitiv Workspace and select More > Open file location 

2. In File Explorer, right-click the Refinitiv Workspace shortcut and select Properties 

3. Add the following parameters to the end of the Target field: 

− --messenger-url="https:\\collab.platform.refinitiv.biz\eikonmessenger"  

Embedded  

Running Messenger traffic through a private network 

To allow Workspace Messenger to route traffic through a private delivery network, you need 

to request that Workspace is permissioned for Messenger Private Delivery, using the 

following values: 

Product code 100464 

Permission Object name COLLRMPRIVATE 
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Appendix H: Unsupported packaging 
methods 

Important: The Unsupported methods section describes packaging methods that are 
neither recommended nor supported by LSEG. 

Supported methods  
LSEG supports the installation of Workspace, using the downloadable executable file:  

− On an individual basis. See the Basic Installation Guide. 

− Using a command line statement. See Installing Workspace, in this document. 

Unsupported methods  
Customers may choose to deploy Workspace using the methods summarized below. While 

we neither recommend nor, on an ongoing basis, support77 these approaches, the steps 

outlined below are understood to work. 

Packaging support 
Customers are entitled to a session of up to two hours of free packaging support, provided by 

one of our Technical Implementation Specialists (TIS). During this time, our specialist 

focuses on providing guidance and offers expert advice on packaging Workspace.  

Packaging support beyond this session will be chargeable. Should you require further 

assistance from LSEG, contact your Implementation Relationship Manager (IRM). 

Installing using an MSI installer 
You may choose to use the MSI installer method in situations where you are blocked from 

downloading and/or installing executable files, due to: 

− A policy that is enforced on the your computer, for example, by an antivirus product, or  

− Your corporate firewall preventing access through their network 

To do this: 

1. Convert the RefinitivWorkspace-installer_x.xx.xx.exe file to an MSI installer. 

This can be done using tools such as MSI Wrapper or Advanced Installer.  

2. Open PowerShell78, with 

admin privileges, and 

navigate to the folder 

containing the .msi file.  

3. To install Workspace 

using the quiet install 

 
77  Refer to the Packaging Support section. LSEG does not maintain test environments for these methods. 
78  For further information, refer to the online Microsoft PowerShell documentation. 

file:///C:/Users/U6084731/OneDrive%20-%20London%20Stock%20Exchange%20Group/TechDoc/W%20O%20R%20K%20S%20P%20A%20C%20E/Workspace%20IT%20Managed%20Installation%20Guide/lseg-workspace-1.23-it-managed-installation-guide%20-%20123.02%20d02.docx%23_Unsupported_methods
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/basic-installation-guide.pdf
file:///C:/Users/U6084731/OneDrive%20-%20London%20Stock%20Exchange%20Group/TechDoc/W%20O%20R%20K%20S%20P%20A%20C%20E/Workspace%20IT%20Managed%20Installation%20Guide/lseg-workspace-1.23-it-managed-installation-guide%20-%20123.02%20d02.docx%23_Installing_Workspace
https://www.exemsi.com/
https://www.advancedinstaller.com/
https://learn.microsoft.com/en-us/powershell/scripting/overview?view=powershell-7.3
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method, use the command79: 

Start-Process RefinitivWorkspace-installer_x.xx.xx.msi -ArgumentList 

"/quiet"  

A system test is performed and LSEG Workspace is installed. 

Deploying using Microsoft Intune 
Using Microsoft Intune, you may be able to deploy Workspace to users in your organization.  

Pre-requisites 

The following are the pre-requisites for machines on which Microsoft Intune is used and 

applies to the machines to which Workspace is to be deployed. These requirements may not 

align with those of LSEG Workspace80:  

− Use Windows 10 version 1607 or later (Enterprise, Pro, or Education editions)81 

− Machines (or devices) to which Workspace is to be deployed must be  

− Enrolled in Intune, and 

− One of the following82:  

− An Azure AD registered device 

− An Azure AD joined device 

− A hybrid Azure AD joined device 

− The installation file size must not be greater than 8GB. 

Deployment overview 

The Workspace installer file, RefinitivWorkspace-installer_x.xx.xx.exe, must be 

converted to a file with an .intunewin extension. The tool used to do this can be found on 

the Prepare Win32 app content for upload page. 

Creating the temporary folders 

1. Download the Content Prep Tool zip file and extract the tool (IntuneWinAppUtil.exe). 

2. In the Windows %temp% folder, create the following folders:  

− 1-LSEG_Workspace  

− 2-IntuneAppsLSEG_Workspace 83 

− 3-IntuneWinAppUtil  

3. In the LSEG_Workspace folder, add the following files:  

− RefinitivWorkspace-installer_x.xx.xx  

− install.cmd  

 
79  This command line instruction is used to install Workspace on one machine. For mass deployment, add the 

command to your deployment portal (Microsoft System Center Configuration Manager, for instance). 
80  For further information, refer to the Workspace System Requirements. 
81  This requirement applies to all machines that are to be managed by Intune. 
82  For further information about Azure device categories, refer to the Concept section under Azure AD device 

identity documentation. 
83 The 2-IntuneAppsLSEG_Workspace folder acts as the repository for the converted installation file. 

https://learn.microsoft.com/en-us/mem/intune/apps/apps-win32-prepare#convert-the-win32-app-content
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/pre-release/system-requirements-pr.pdf
https://learn.microsoft.com/en-us/azure/active-directory/devices/
https://learn.microsoft.com/en-us/azure/active-directory/devices/
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− uninstall.cmd  

Sample install.cmd script: 

START %temp%\1-LSEGWorkspace\RefinitivWorkspace-installer_x.xx.xxx.exe --
user --silent --installpath="%localappdata%\Refinitiv\Refinitiv Workspace" -

-cachepath="%localappdata%\Refinitiv\Refinitiv Workspace\cachepath" --

installerlogpath="%localappdata%\Refinitiv\Refinitiv 

Workspace\installerlogpath" --logpath="%localappdata%\Refinitiv\Refinitiv 

Workspace\logpath" --shortcuts="%localappdata%\Refinitiv\Refinitiv 

Workspace\shortcuts" 

Sample uninstall.cmd script: 

START %temp%\1-LSEGWorkspace\RefinitivWorkspace-installer_1.22.303.exe --
uninstall --silent 

4. In the 3-IntuneWinAppUtil folder, save the IntuneWinAppUtil.exe tool. 

Running the conversion tool 

Once the folders have been created, use the IntuneWinAppUtil.exe tool to create the 

Intune file. 

1. Open the 3-IntuneWinAppUtil 

folder and double-click the 

IntuneWinAppUtil.exe tool. 

2. At the Please specify the 

source folder prompt, type 

the path to the first temporary 

folder and press Enter.  

For example:  

C:\temp\1-LSEG_Workspace  

3. At the Please specify the setup file prompt, type the name of the Workspace 

installation file and press Enter.  

For example: 

RefinitivWorkspace-installer-win32-x64_1.23.269.exe  

4. At the Please specify the 

output folder prompt, type 

the path to the second temporary 

folder and press Enter.  

For example:  

C:\temp\2-

IntuneAppsLSEG_Workspace   

5. For the Do you want to 

specify catalog folder 

prompt, type N and press Enter. 

The conversion tool starts converting the installation file to .intunewin format. 
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Installing through Intune 

Once the .intunewin file has been created in the 2-IntuneAppsLSEG_Workspace folder, 

follow the instructions in the Add, assign, and monitor a Win32 app in Microsoft Intune page. 

 Use the information in the following table as a reference when configuring Intune: 

Intune Name Mode Command 

Refinitiv Workspace - user mode 

 

--user 

 

RefinitivWorkspace-installer-win32-
x64_1.19.448.exe --user --silent 

Refinitiv Workspace - machine-
autoupdate-peruser mode 

 

--machine-autoupdate-peruser 

 

RefinitivWorkspace-installer-win32-
x64_1.19.448.exe --machine-
autoupdate-peruser 

Refinitiv Workspace - machine-
autoupdate-service mode 

 

--machine-autoupdate-service 

 

RefinitivWorkspace-installer-win32-
x64_1.19.448.exe --machine-
autoupdate-service 

Refinitiv Workspace - machine-
autoupdate-no mode 

 

--machine-autoupdate-no 

 

RefinitivWorkspace-installer-win32-
x64_1.19.448.exe --machine-
autoupdate-no 

 

 

https://learn.microsoft.com/en-us/mem/intune/apps/apps-win32-add
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Appendix I: Troubleshooting 

In this section 

− Crash information uploads 
− Shared configuration file bug 

− Installer help parameter 

− Error codes 

− Logging 

− Networking issues 

− Using the Video Recorder tool 

− Known issues in Citrix environments 

Crash information 
uploads  
If a crash occurs, Workspace sends the dump 

file to the internal Support platform.  

Whenever possible, Workspace also uploads 

session logs to provide more information to the 

support teams.  

Crash and log files are sent to the following 

internal Support platform:    

https:\\dst.platform.refinitiv.com\ 

JSON coding changes 
The following additional, advanced syntax changes have been made to the coding of JSON 

files: 

− Add single line comments, using // at the beginning of the line 

− Multiple line comments, using /* text text text */  

− Empty lines are permitted 

− Indentation errors are skipped and do not cause interruptions 

− The last line of the file is not required to end with a comma 

Error codes 
The following error codes may be reported during an installation failure: 

Error reported Code Summary 

UNSUPPORT_PLATFORM 100 Unsupported Platform. 

FAILED_TO_INSTALL 101 Failed to install Workspace. 

FAILED_TO_COPY_FILES 102 Failed to copy files to %AppData%\Refinitiv. 

https://dst.platform.refinitiv.com/
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Error reported Code Summary 

CANNOT_GET_FOLDER_SIZE 103 Cannot get folder size for stamping to Add/Remove program. 

FAILED_TO_INSTALL_ADD_REMOVE_PROGRAM 104 Failed to install Add/Remove program. 

FAILED_TO_INSTALL_WINDOWS_REGISTRY 105 Failed to install Windows registry. 

FAILED_TO_CONFIG_PRODUCT 107 Failed to create/update config product. 

FAILED_PREREQUISITE_CHECK 108 Failed prerequisites check. 

ALREADY_INSTALLED 109 Already installed 

NO_INSTALLATION_FOUND 110 No installation found 

FAILED_TO_UNINSTALL 201 Failed to uninstall 

FAILED_TO_UNINSTALL_CANNOT_REMOVE 
202 

Failed during uninstall process. Cannot remove Refinitiv 
Workspace folder 

UNSUPPORT_PLATFORM 300 Unsupported operating system. 

INVALID_COMMAND_ARGUMENT 301 Invalid parameter used in installation command line.84 

INVALID_ARGUMENT_VALUE 302 Invalid parameter used in installation command line  

CUSTOM_PATH_NOT_ALLOW 

303 
Make sure that the path(s) entered in parameter(s) are 
compatible with the chosen installation mode 

ALREADY_INSTALL 310 Workspace is already installed 

ALREADY_INSTALL_DIFFERENT_MODE 
311 

You cannot proceed with the installation, as Workspace is 
already installed with a different installation mode  

OFFICE_REGISTRY_CLI_NOT_SUPPORT 
321 

You must update Workspace to version 1.21 or higher to use 
the --office-registry command 

UPDATE_OFFICE_REGISTRY_CLI_NOT_SUPPORT 
322 

You must update Workspace to version 1.21 or higher to use 
the --update-office-registry command. 

UPDATE_BLOCKED_BY_OFFICE_REGISTRY 

323 
Update is blocked because your office registry is set to 
HKCU. Reset using --update-office-registry=HKLM before 
performing the update again. 

NOT_ALLOW_ROLLBACK_BY_OFFICE_REGISTRY 

324 
Rollback is blocked because your office registry is set to 
HKCU. Reset using --update-office-registry=HKLM before 
performing the update again. 

SYSTEM_CHECK_FAILED 350 The installer was unable to run the system test successfully 

SYSTEM_CHECK_UNKNOWN_RESULT 353 The installer was unable to run the system test successfully 

NOT_ENOUGH_DISKSPACE 351 Insufficient disk space on which to install Workspace 

NO_ADMIN_RIGHT 352 Workspace installation requires Administrator privileges 

FILE_IS_LOCKED 400 Process stopped as Workspace file(s) in use 

FILE_IS_MISSING 
401 

Workspace installation executable does not contain all 
required files 

INSTALLER_FILE_CORRUPT 451 Workspace installation executable is corrupt 

NO_INSTALLATION_FOUND 500 Workspace installation file was not found 

MS_OFFICE_PROCESS_IS_RUNNING 
501 

Installation stopped as Microsoft Office applications are 
running 

FAILED_TO_HANDLE_FILE 801 Unable to access Workspace installation files 

FAILED_TO_CONFIG_PRODUCT 802 Unable to configure product 85 

FAILED_TO_ADD_REMOVE_PROGRAM 810 Unable to update Add/Remove Programs 

FAILED_TO_ADD_WINDOWS_REGISTRY 811 Unable to update Windows registry 

UNKNOWN_ERROR 999 Unknown error 

Logging  

Uploading Workspace logs 
You can upload Workspace logs by using: 

− A menu option   

 
84 See Workspace Help parameter options. 
85 In this event, contact Support. You will also be asked to provide your installation log file. 
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− Excel launcher 

Menu option  

− From the Help menu, select Upload 
logs.  

 

 

 

Excel launcher 

If you are logged into Excel:  

1. Press Shift+Ctrl+Space. 

2. In the Search window, type /log. 

3. Click Upload Logs. 

Log upload workflow  
By user request or if a crash occurs, Workspace 

sends the contents of the application logs folder to 

the internal Support platform:  

https:\\dst.platform.refinitiv.com\ 

To save bandwidth, log uploads are sent in chunks of 

no more than 5Mb. Additionally, logs that have 

already been uploaded are not uploaded again.  

You can also upload log files to the desktop support 

site using the following command line: 

RefinitivWorkspace.exe --upload-logs 

https://dst.platform.refinitiv.com/
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Log upload troubleshooting 
For troubleshooting purposes, the settings86 shown in the table below can be written to the 

user-settings.json or machine-settings.json file: 

Setting Purpose 

EIKON.LOGSUPLOAD.VERBOSEOUTPUT set to true to have some output generated in the 
console. 

EIKON.LOGSUPLOAD.DEACTIVATEENCRYPTION set to true to send the logs without encryption. 

EIKON.LOGSUPLOAD.WRITETEMPFILESONDISK set to true to write the original and the crypted zips in 
the %TEMP% folder. 

EIKON.LOGSUPLOAD.TESTDECRYPTIONLOCALLY set to true to test that decryption works locally (useful 
with VERBOSEOUTPUT and/or WRITETEMPFILESONDISK). 

 

Networking issues 
After installing Workspace, you have the 

option of using the web logger command to 

troubleshoot networking issues. To do this:  

− Use the command RefinitivWorkspace.exe --web-logger, or 

− Activate it using the Web Logger checkbox under Configuration Manager > Logs: 

To troubleshoot networking issues: 

1. Launch Workspace with the --web-logger parameter, using the Command Prompt, or 

through the Configuration Manager. 

2. Enter your credentials and login. 

3. Navigate to the log folder location.  

4. Open the most recently created desktop log file (web-requests.log) 87. This file is 

created and available with all captured web calls from Workspace. 

Resetting Electron application data 
You can use the following parameters to delete application data – configuration files, caches, 

preferences, and settings – resetting Electron.  

Close all Workspace applications before running these commands. 

To do this, depending on your requirements:  

− Run RefinitivWorkspace.exe with a parameter, or 

− Select a cache clearing function under Configuration Manager > Cache 

Depending on the option chosen, resetting the cache has the following effect: 

Configuration 
Manager function 

Parameter Effect 

Clear all cache --resetCache 
Resets the product cache of Workspace to its default 
state. That is, as it would be after a fresh installation. 

Clear Electron cache --resetElectronCache 
Reset the Electron cache of Workspace to its default 
state 

. 

 
86 By default, all these settings are set to FALSE. 
87 When Workspace shuts down, it generates both the web-requests.log file and a HAR-based topology log file. 
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Using the Video Recorder tool 
The Video Recorder tool allows you to capture and save video footage of your entire desktop 

or a particular screen. This is particularly useful for capturing issues you are experiencing 

with your environment to provide additional information 

to Support. 

You can start the tool from the Help menu or by using a 

parameter.  

Starting the tool from the Help 
menu 
To do this: 

1. Open the Help menu by clicking the ? icon.  

2. Select Video Recorder from the menu. 

Starting the tool using a parameter 
Run Workspace with the --video-recorder parameter. This can be done either by:  

− adding the parameter to the application shortcut by editing its properties, or  

− using the appropriate command line statement: 

Windows "%LOCALAPPDATA%\Refinitiv\Refinitiv Workspace\RefinitivWorkspace.exe" --video-recorder  

macOS "/Applications/Refinitiv Workspace.app/Contents/MacOS/RefinitivWorkspace" --args --video-recorder  

 

The following dialog is 

displayed: 

 

 

 

 

Capturing a 
video 
To capture a video, do the 

following:  

1. Click Start. 

2. In the dialog that is 

displayed, choose 

whether to capture 

video of your whole 

desktop or of a specific 

screen.  
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While the video is recording, a dialog is displayed which shows 
the current size of the video file, as it is recording.  

3. Once you have captured the content you require, click Stop. 

4. Then, in the main 

dialog, click Save.  

 

 

A Windows Explorer 
dialog is displayed, with 
the Downloads folder 
open, by default.  

5. Optionally, navigate to a 

different download 

folder.  

6. Click Save. 

7. Contact Support, who will guide you regarding the submission of this file. 

Using the Logs Viewer 
The Logs Viewer facility allows you to view a comprehensive and filterable list of log entries 

that were captured in the main and other files. 

You can start the facility from the Help menu or by using 

a parameter.  

Opening the facility from the Help 
menu 
To do this: 

1. Open the Help menu by clicking the ? icon.  

2. Select Logs Viewer from the menu. 

Opening the facility using a 
parameter 
Run Workspace with the --logs-viewer parameter 88. This can be done either by:  

− adding the parameter to the application shortcut by editing its properties, or  

− using the appropriate command line statement: 

Windows "%LOCALAPPDATA%\Refinitiv\Refinitiv Workspace\RefinitivWorkspace.exe" --logs-

viewer  

macOS "/Applications/Refinitiv Workspace.app/Contents/MacOS/RefinitivWorkspace" --args --logs-

viewer  

 
88 See the Logs Viewer parameters section.  

https://my.refinitiv.com/content/mytr/en/helpandsupport.html
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Logs Viewer parameters 

The table below lists valid parameters for the --logs-viewer command line statement: 

Parameter Description 

--logs-viewer Select the main file, which is the log of the current Workspace session, in 
the current log folder 

--logs-viewer=* Select all files in the current log folder 

--logs-viewer=<prefix> Select the files in the log folder that have the defined <prefix>. Where 
<prefix> is one of the following: 

− main – Workspace desktop log 

− excel – Workspace for Excel log 

− renderer – Workspace window rendering log 

− node – Node.js log 

--logs-viewer=<file> Select the specified log file. For example: 

--log-viewer="%LOCALAPPDATA%\Refinitiv\Refinitiv Workspace 

Logs\Desktop.20230104.151635.p8956\renderer-1-r6.20230104.p22728.log" 

--logs-viewer=“<folder path>” Select the main log file from the specified <folder>. For example: 

--log-viewer=“%LOCALAPPDATA%\Refinitiv\Refinitiv Workspace Logs" 

--logs-viewer=“<folder path>\*” Select all files from the specified <folder>. For example: 

--log-viewer="%LOCALAPPDATA%\Refinitiv\Refinitiv Workspace Logs\*" 

--logs-viewer=“<folder 

path>\<prefix>” 

Select files with the specified <prefix> from the specified <folder>. For 
example: 

--log-viewer="%LOCALAPPDATA%\Refinitiv\Refinitiv Workspace 

Logs\renderer" 

 

Overview of the Logs Viewer panel 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Header – 
Containing file 

name and length 

Show dates as UTC – date and time is converted to 
UTC time zone. 

Show Dates as Local – Default. Date and time shown 
in local time zone. 

Auto-scroll – Updates to a single selected file are 
tracked and the new data is added. Select this to scroll 
automatically to the bottom when an update occurs. 

Log entry list, 
where the 
background color 
indicates the type 
of entry: 

     Error 

     Warn 

     Info 

     Debug 

     Verbose 

Tags are extracted from 
the log text when there is 
an info, error, warn, and 

so on, prefix 

Select from a list of all log 
files, then click GO to 

confirm your selections 

What – the type of 
file. That is, main, 

excel, renderer, 
and so on. 

Where – file name, 
if more than one of 
that type, and line 

number 

When – date and 
time stamp (local or 

UTC) 

Shift – time 
variance from first 

log entry 

Level – error, 
warning, info, 

debug, or verbose 

Tags – [XYZ] 
markers found in 

the log entry 

Textual search 
of all filtered log 

records 

The contents of the 
selected files are 

saved to a .csv file 
in 

%LOCALAPPDATA%\Tem

p\Refinitiv 
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Importing files  
Under the Files filter, log files held in folders 

that are not listed in the Logs Viewer can be 

imported into the viewer. 

To do so: 

1. In Windows Explorer, open the folder 

containing the file(s) to import.  

2. Select the file(s). 

3. Drag the files into the Logs Viewer panel 89. 

− When you release your pointing device, the 
files are added to the viewer under the 
folder in which they were located.  

Using the Actions menu 
The Actions menu, an ellipsis found under the Actions column, can be used to copy the 

contents of specific log file entries.  

To open the Actions menu:  

1. Hover your cursor over the Actions column of the 

entry to copy. 

− An ellipsis appears.  

2. Click the column to display the menu.  

Choose from the following options: 

 

 

 
89 You can copy the files into the existing folder by holding the Ctrl key before releasing your pointing device. 

Copy raw line Copy the original data from the log file to the 
clipboard. 

This copies the entire contents of the line, 
including date, time, and so on. 

Copy Text Column Copy the content of the Text column to the 
clipboard. 
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Appendix J: Known issues  

DPRM connection issue 
If DPRM-related settings are read incorrectly, it may result in DPRM failing. In this case, the 

No working server available for DPRM log file error message. 

Important: The workaround, below, is only required for installations of Workspace 1.23 
and has been fixed in the Workspace 1.24 release. Therefore, if you have upgraded to 
1.24, these settings will need to be removed. 

As a workaround, the following settings should be added to your configuration file: 

{ 

"EIKON.STREAMING.API.__CORE__.PLUGINS.ADDITIONAL.LOCAL": "%.7%,%.8%", 

"EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.1": 

"%EIKON.STREAMING.API.LOCAL.DACS.DPRM.SERVERS%", 

"EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.2": 

"%EIKON.STREAMING.API.LOCAL.DACS.DPRM.PORT%", 

"EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.3": 

"%EIKON.STREAMING.API.LOCAL.DACS.USERNAME%", 

"EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.4": 

"%EIKON.STREAMING.API.LOCAL.DACS.FORCECASE%", 

"EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.5": "%USERDETAILS.UUID%", 

"EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.6": 

"%EIKON.STREAMING.API.LOCAL.DACS.DPRM.INTERVAL%" 

} 

Retrieving permissions 
If you use this workaround, the default for retrieving permissions from the LSEG Real-Time 

Advanced Distribution Server, to which you are currently connected, will not work. As such, 

you need to specify a value for the following setting: 

EIKON.STREAMING.API.LOCAL.DACS.DPRM.SERVERS 

Limitations 
There are several impacts of these additional settings that are described below.  

Defining additional local connections 

If you use additional local connections, you will be limited to two. These are the connections 

configured using the following settings: 

EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.7  

EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.8  

Using Configuration Manager  

This workaround will severely impact use of Configuration Manager. 

Certain components of Configuration Manager – Streaming feeds, for instance – will not 

initialized properly. As such, any changes made in Configuration Manager will not persist 

and, therefore, will have no effect on Workspace. 
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Exporting data to Excel 
This affects users who are not permitted to 

access the Windows operating system 

tool90, PowerShell, only.  

An error message may be displayed when 

attempting to export data to Excel.  

 This has been noted to impact users of 

the SDC PLATINUM application 

especially. 

Excel add-in loading 
issues 

Trust Center policies 
If the Group and/or Microsoft 365 Trust Center policies are set to deny the use of Web add-

ins, certain Workspace add-in menu ribbon items, such as Deals BI, may not load. 

To resolve this issue, do the following: 

1. Open a Microsoft 365 file (Word document, Excel spreadsheet, …) 

2. Open the File menu 

3. Select Options 

4. In the Options dialog, select Trust Center 

5. Click the Trust 

Center Settings… 

button 

6. Select Trusted 

Add-in Catalogs 

7. Uncheck the Don’t 

allow any web 

add-ins to start 

checkbox  

Workspace installations without automatic update91 
For users installing Workspace using –-machine-autoupdate-no, the Excel add-in does 

not load correctly on non-virtual machines. This is because the default location of the Office 

registry key is registered at HKLM. 

To correct the registry key location, use the command: 

<install path>\RefinitivWorkspace.exe --update-office-registry=HKCU 

 
90 For a list of required operating system tools, refer to Operating system tools 
91 PCN206237 provides more information about this fix. 

https://my.refinitiv.com/content/mytr/en/product-notifications/details.html?id=PCN206237
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Installing standalone Workspace Messenger  
For Workspace 1.21 only, installation or update of Workspace Messenger alone is done 

using command line statements. That is:  

Action Command 

Installation RefinitivWorkspace-installer_x.xx.xx.exe --<mode> --messengeronly 

Update  RefinitivWorkspace-installer_x.xx.xx.exe --<mode> --messengeronly 

Uninstallation <install path>\Refinitiv Workspace\RefinitivWorkspace.exe --uninstall 

Contributions (RtContribute) 
The Refinitiv Workspace - Excel (Workspace ribbon) add-in was added in Workspace 

version 1.16. The following list summarizes the known issues and their solutions or when 

they are to be addressed. 

Issue Solution/To be addressed in 

RTDS requires updating to a new Data Dictionary version.  

LSEG Real-Time Advanced Distribution Server (formerly ADS) 

version 3.5.2 L1 does not support the contribution from Workspace 

Excel. 

Install version 3.5.2 L3 92 or higher. 

POS and LANGUAGE parameters are not supported. Requires 

sending data in RMTES encoding.  

Only UTF-8 is supported by the API 

LSEG Real-Time Advanced Distribution Server version 
issues 
There were several issues with the handling of WebSocket connections in the initial release 

of version 3.5.2, which were only partially resolved in 3.5.2 L2.  

Further issues concerning WebSocket connections were addressed in the L3 release, 

together with minor changes to the default settings, which improved the handling of larger 

messages.  

Virtualized environment issues 
Important: If you encounter an issue; LSEG requests that you confirm the issue has been 
reproduced in a non-virtualized environment. 

CVAD environments 
This section lists all known issues for running Workspace on a CVAD environment: 

Subject 
Jira  

reference 
XenApp  
pub. app 

XenApp  
pub. d’top 

Xen 
Desktop 

RTGet template which has 10k functions is not 
responding on applying "save as val- agreeues-
Workbook" 

EFO-8412    

Refinitiv Workspace - Excel is not automatically sign 
in and retrieve the data when Open saved 
Functional template + native excel via command line 

EFO-8579  
  

HelpApi request doesn't work HELP-5828    

 
92 See also Creating an internal connection.  
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Subject 
Jira  

reference 
XenApp  
pub. app 

XenApp  
pub. d’top 

Xen 
Desktop 

All menus are displayed as separate entry in 
taskbar 

SAP-9231    

Toast UI is displaying as separate entry in taskbar SAP-9233    

Notification Centre: Toast still appears when user 
activate Focus Assist on local machine 

SAP-9617    

There is a small black area around toasts SAP-9620    

Shortcut (ALT + S) doesn't work SAP-10009   
 

RW in XenApp does not support custom protocols SAP-10157    

Black areas are shown near guidelines and 
snapping lines 

SAP-10399    

Snapping/grouping features breaks after moving a 
tile (moving frame) 

SAP-10368    

Black screen is displayed around opened window 
for area and full screen screenshot 

SAP-10785    

Messenger on Citrix XenApp environment 
intermittently freeze while typing in the text box 

SAP-11267    

File type is not added into save dialogue SAP-14187    

Unknown container type and app-name into 
UsTracking evet for Tile, Modal window 

SAP-18302    

If the 'Position of Toast' sets as 'Bottom - Right or 
Left', it's not working as expected 

SAP-24424    

Three horizontal dots (ellipsis) option is not 
appearing in the toast notification 

SAP-24438    

Not able to close the popped-out conversation in the 
system task bar 

SAP-24439    

Deep links are not opened on virtual desktop 
machines 

SAP-25517    

[Widely:] Palo Alto Networks TS Agent can raise 
problems - whitelisting 

---    

 

VMware environments 
This section lists all known issues for running Workspace on a VMware Horizon 8 

environment: 

Subject Jira reference 
Horizon 

virtual apps 

There's only 'Close window' in the task bar SAP-10823  

Published Apps - Do not disturb option is activated on Published Apps 
when Focus assist is OFF in OS settings 

SAP-10972 
 

Published Apps - Impossible to copy screenshot to clipboard for 
Virtual App 

SAP-11011 
 

Tiles - Snapping line and guideline are visible only after dropping a tile SAP-11025  

Tiles - Group movement is not working properly SAP -11026  

Tiles - Single tile resizing works for snapped or grouped tiles SAP-11027  

Impossible to open deep link SAP-11955  

Published Apps - RW desktop 1.19 is not resized SAP-22571  

Tiles - Pinned tile manager can be moved SAP-22620  
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SSL inspection support 
LSEG does not support or enforce SSL inspection, sometimes referred to as TLS/HTTPS 

Interception. 

If clients use SSL inspection, they must configure URL filtering profiles not to enforce SSL 

inspection on LSEG domains, such as *.refinitiv.com, *.refinitiv.net, *.refinitiv.biz. 

Real-Time server disconnections 
In the event where the LSEG Real-Time Distribution System disconnects immediately 

following a successful mount, refer to Creating an internal connection.        

Cache path definition 
An alternative cache path can be defined for Workspace during its installation, using the 

parameter:  

RefinitivWorkspace-installer_x.xx.xx.exe --cachepath=”<folder_path>”  

However, currently, this does not re-route the entire content of the Refinitiv Workspace 

folder in the cache. That is, while the electron folder is moved to the new location, the 

following subfolders are not:  

− Config 

− Dictionaries 

− Data API Proxy 

− File Links 

Signing in automatically 
When users first log into Workspace, they have the option of 

choosing to sign in automatically in future, which creates a cookie in 

the electron cache for the user. 

However, if electron is upgraded to a higher version, the cache is 

cleared and users are expected to sign in again. 

 As this may occur many months later, users may have lost their 

credentials. 

Rolling back 
If your instance of Workspace was upgraded automatically, you can return to the previous 

version of Workspace by using the rollback parameter in the command line: 

"<Install Path>\Refinitiv\Refinitiv Workspace\RefinitivWorkspace.exe" 

--rollback 

However, this command also disables the automatic update feature for subsequent releases 

of Workspace.  



Appendix J: Known issues 
 
 

LSEG Workspace Installation and Configuration Guide 

Document Version 124.02 

77 

Rolling forward command support 
Due to changes to the Workspace architecture, the --rollforward command line 

parameter is only valid for version 1.19 or higher. Also, this command can only be used after 

a --rollback operation has been performed.  

 

 

 

Legal Information 

© LSEG 2023.  All rights reserved. 

LSEG does not guarantee that any information contained in this document is and will remain accurate or that use of the information will ensure correct and faultless operation of the 

relevant service or equipment. LSEG, its agents and employees, accepts no liability for any loss or damage resulting from reliance on the information contained in this document. 

This document contains information proprietary to LSEG and may not be reproduced, disclosed, or used in whole or part without the express written permission of LSEG. 

Any software, including but not limited to, the code, screen, structure, sequence, and organization thereof, and documentation are protected by national copyright laws and international 

treaty provisions. This document is subject to U.S. and other national export regulations. 

Nothing in this document is intended, nor does it, alter the legal obligations, responsibilities, or relationship between yourself and LSEG as set out in the contract existing between us. 


	About this document
	Intended readership
	LSEG Workspace rebranding
	Software releases and end of life
	Contact information

	Pre-requisites
	In this section
	Verifying system requirements
	System and network testing

	Virtualized environments
	VDI support


	Installing Workspace
	In this section
	PC installation
	Installation method summary table
	Workspace Help parameter options
	Customizing paths
	Performing a User installation
	Performing a Machine installation
	With the auto-update Windows service
	With auto-update per user
	Without auto-updates

	Performing an installation using your Single Sign On URL
	Using a shared configuration file
	Using the command line


	Citrix installation
	Installing Workspace for Citrix XenApp
	Publishing Workspace applications for XenApp

	Installing Workspace for Citrix XenDesktop

	VMware installation
	Installing Workspace for VMWare Horizon virtual app
	Configuring virtual applications on Windows Server

	Installing Workspace for VMWare Horizon virtual desktop

	Running Workspace web access
	Accessing through the Internet
	Accessing through a private network

	Post installation testing
	Downloading the tool
	Running the tool


	Uninstalling Workspace
	Using the installer user interface
	Using a command
	Log file location

	Running a mass deployment
	About mass deployment
	Prepare installation and shared configuration files
	Prepare the installation command line and an install script
	Ensure all necessary files are in a shared location
	Execute the install script using your mass deployment tool
	Script examples


	Configuring Workspace
	In this section
	Configuration Manager command lines
	Setting up configuration manager
	Converting and modifying an Eikon configuration file
	Creating a new configuration file manually
	Configuring Single Sign On (SSO) for Workspace web access

	Appendix A: Folders and files
	In this section
	Packages
	Download locations
	Executable file sizes

	Server software
	Versions
	Creating an internal connection
	Configuring multiple servers

	Executable files
	Digital signatures
	Digital certificates for Workspace 1.24 or higher
	LSEG signature
	macOS signature

	Digital certificates for Workspace 1.23 or earlier
	Refinitiv   signatures
	Microsoft signature
	macOS signature


	Registry files
	Configuration file settings
	Shortcuts
	Default folder structures
	Proxies
	Qualified Proxy
	HTTP/1.1 (or above) Compliant Proxy


	Appendix B: Software information and support
	In this section
	Documentation locations
	Export control classification
	Hosted connection item limits
	About LSEG Workspace dialog
	Data dictionary support
	Local mode support

	Appendix C: Command line statements
	In this section
	Installation statements
	Uninstallation statement
	Configuration Manager parameters
	Workspace executable statements
	Installer command line statements


	Appendix D: Automatic update workflow
	Device and installation registration
	Checking new version availability
	Changing the update time
	Setting up a custom scheduler

	Downloading a version and preparing for upgrade
	Checking new package with Desktop Deployment Portal
	Initiating an update
	Upgrade workflow

	Appendix E: Settings
	In this section
	Networking
	Ports
	Communication protocols
	Services
	Financial Community Network and Delivery Direct
	Internet
	Transport Layer Security protocol
	Web hosted services

	Content filtering domains
	Example domain list

	Trusted root certification

	Microsoft Office settings
	Workspace for Excel VSTO add-in
	Workspace add-in

	Customer managed over Internet
	Security
	FIPS
	User Agent

	Enabling the DPRM service
	DPRM settings example


	Appendix F: Shared configuration files
	Configuration override order
	Creating a shared configuration file
	Settings
	Alternative streaming servers
	Protocol support


	Appendix G: Workspace Messenger
	Standalone
	Workspace Messenger private line connectivity

	Embedded
	Running Messenger traffic through a private network


	Appendix H: Unsupported packaging methods
	Supported methods
	Unsupported methods
	Packaging support
	Installing using an MSI installer
	Deploying using Microsoft Intune
	Pre-requisites
	Deployment overview
	Creating the temporary folders
	Running the conversion tool
	Installing through Intune




	Appendix I: Troubleshooting
	In this section
	Crash information uploads
	JSON coding changes
	Error codes
	Logging
	Uploading Workspace logs
	Menu option
	Excel launcher

	Log upload workflow
	Log upload troubleshooting

	Networking issues
	Resetting Electron application data

	Using the Video Recorder tool
	Starting the tool from the Help menu
	Starting the tool using a parameter
	Capturing a video

	Using the Logs Viewer
	Opening the facility from the Help menu
	Opening the facility using a parameter
	Logs Viewer parameters

	Overview of the Logs Viewer panel
	Importing files
	Using the Actions menu


	Appendix J: Known issues
	DPRM connection issue
	Retrieving permissions
	Limitations
	Defining additional local connections
	Using Configuration Manager


	Exporting data to Excel
	Excel add-in loading issues
	Trust Center policies
	Workspace installations without automatic update

	Installing standalone Workspace Messenger
	Contributions (RtContribute)
	LSEG Real-Time Advanced Distribution Server version issues

	Virtualized environment issues
	CVAD environments
	VMware environments

	SSL inspection support
	Real-Time server disconnections
	Cache path definition
	Signing in automatically
	Rolling back
	Rolling forward command support


